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�ata �����s�t�on an� ��o�ess�n� �e�o�t

���� ���� Ferdinand R. Hassler
Chief of Party: LCDR Benjamin K. Evans, NOAA

Year: 2011
Version: 1.0

Publish Date: 2012-04-27

� ������ent

��� ����e� �essels

����� ���� ���� �e���nan� �� �assle�

Name NOAA Ship Ferdinand R. Hassler
Hull Number S250
Description Ferdinand R. Hassler is a small waterplane area, twin-hull coastal mapping vessel.   
Utilization Hydrographic Survey

Dimensions
LOA 37.7 meters
Beam 18.5 meters
Max Draft 3.85 meters

Most Recent Full
Static Survey

Date 2009-11-04

Performed By Raymond C. Impastato, Professional
Land Surveyor

Discussion

This survey was provided by the
shipbuilder, V.T. Halter Marine, and
performed in the shipyard prior to
delivery.

Most Recent Partial
Static Survey

Date 2011-03-30
Performed By Kevin Jordan, NGS

Discussion

This survey was performed after
the POS/MV antenna mounts were
reconfigured from the mast to newly
fabricated mounts; ties the POS antennae
into benchmarks on the 02 level.

Most Recent Full
Offset Verification Full offset verification was not performed.
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Most Recent Partial
Offset Verification Partial offset verification was not performed.

Most Recent Static
Draft Determination

Date 2012-07-12

Method Used Calculation from design waterline and
measured offsets

Discussion

Design waterline of 3.85m and measured
offsets to IMU were used to determine
static draft of reference point. Draft
of ship is operationally managed
with ballast to achieve design draft.
Uncertainty is estimated at 0.05 m.

Most Recent
Dynamic Draft
Determination

Date 2011-07-12

Method Used Ellipsoid referenced dynamic draft
(ERDDM)

Discussion

Data were acquired with canards 15
degrees up, 15 degrees down, and at zero
trim angle. The zero trim angle results
are used for the dynamic draft table in
the Caris HVF files. During all surveys
operations, the canards are set to zero
trim angle.

Figure 1: NOAA Ship Ferdinand R. Hassler, Starboard View
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Figure 2: NOAA Ship Ferdinand R. Hassler, Bow and Hull View

A.2 Echo Sounding Equipment

A.2.1 Side Scan Sonars

A.2.1.1 Klein 5000

Manufacturer Klein
Model 5000

Description

High-speed, high-resolution side-scan sonar (SSS) system is a multibeamforming acoustic
 imagery device with an operating frequency of 455 kHz and vertical beam angle of 40°.
  The KLEIN 5000 system consists of a KLEIN 5500 towfish, a Transceiver/Processing
 Unit (TPU), and a computer for user interface.  The towfish is towed via 3/8" armored
 coaxial cable connected to a DT marine electro-hydraulic winch (s/n 1271 302 OEHLW3R)
 equipped with a Klein slip ring (model: 14103033, s/n 1802003).  The winch is controllable
 from the sonar operators station.  Cable out is measured with a 3PS cable counter integrated
 with a General Oceanics model 4042 sheave.  The sheave is mounted on the A-frame and is
 the tow point for offsets measurements.  Cable counter accuracy was verified on 9/15/2011
 using a known length of line.   

Serial
Numbers

Vessel Installed
On

S250

TPU s/n 138

Towfish s/n 292
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Specifications

Frequency 455 kilohertz

Along Track
Resolution

Resolution 10  centimeters  

Min Range 1 meters  

Max Range   

Across Track
Resolution 3.75 centimeters

Max Range
Scale 250 meters

Manufacturer
Calibrations

Vessel Installed
On

S250

Calibration
Date

2012-07-07

Figure 3: Klien 5500 configured for towing

A.2.2 � ulti�eam Echosounders

A.2.2.1 �eson �125

Manufacturer Reson
Model 7125

Description

Port system of a dual-head configuration.  This sonar is mounted in the port hull with
 a 4.5 degrees outboard tilt.  The sonar can be operated independently, but is typically
 operated in conjunction with the starboard system as a dual-head system.  When
 operated as a dual-head system, the port unit acts as the master and controls the ping
 interval of the starboard system.  Because the systems cannot ping simultaneously
 without interference, the system alternates pings between the two heads in a "ping-
pong" configuration.  
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Serial Numbers

Vessel Installed On S250

Processor s/n 51180

Transceiver s/n 56689

Transducer s/n n/a

Receiver s/n 3906091

Projector 1 s/n 506078

Projector 2 s/n None

Specifications

Frequency 396 kilohertz

Along Track 1.0 degrees
Beamwidth

Across Track 0.5 degrees

Max Ping Rate 50 hertz

Beam Spacing
Mode Equidistant 

Beam Spacing
Number of
Beams 512

Max Swath Width 128 degrees

Depth Resolution 3 centimeters

Manufacturer
Specified 400 meters 

Depth Rating
Ship Usage 60 meters

Manufacturer
Calibrations Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On S250

Methods Reference surface comparison

Results

A reference surface comparison was performed on May 18, 2011
(DN138). Tidally corrected surfaces were generated for the port and
starboard 7125 systems and the surfaces differenced. The depths from the
port 7125 were on average 0.04 meters shallower than the depths from
the starboard 7125. The distribution of differences was close to normally
distributed with a standard deviation of 0.03 meters. The accuracy of the
starboard head was later verified with a lead line.

Snippets Sonar has snippets logging capability.
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Figure 4: 7125 Housing flush mounted on hull

Figure 5: Histogram of depth differences from reference surface comparison
between port and starboard 7125. Depths from port system average 0.04

meters shallower than starboard with a standard deviation of 0.03 meters. 

A.2.2.2 �eson �125

Manufacturer Reson
Model 7125

Description

Starboard system of a dual-head configuration. This sonar is mounted in the starboard
 hull with a 4.5 degrees outboard tilt. The sonar can be operated independently, but is
 typically operated in conjunction with the port system as a dual-head system.  When
 operated in dual-head mode, the port unit is configured as master. 
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Serial Numbers

Vessel Installed On S250

Processor s/n 1908005

Transceiver s/n 51517

Transducer s/n n/a

Receiver s/n 3205736

Projector 1 s/n 107060030

Projector 2 s/n None

Specifications

Frequency 396 kilohertz

Along Track 1.0 degrees
Beamwidth

Across Track 0.5 degrees

Max Ping Rate 50 hertz

Beam Spacing
Mode Equidistant 

Beam Spacing
Number of
Beams 512

Max Swath Width 128 degrees

Depth Resolution 3 centimeters

Manufacturer
Specified 400 meters 

Depth Rating
Ship Usage 60 meters

Manufacturer
Calibrations Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On S250

Methods Lead line comparison

Results

On July 26, 2011 (DN207) a static lead line comparison was performed
relative to the waterline. While the ship was alongside a pier, a leadline
was lowered to the sea floor in the field of view of the sonar while
logging sounding data. Because the leadline was visible in the water
column display, the beams at the leadline measurement location could
be identified. The logged data was processed through Caris using
standard methods with zero-tides applied to yield a waterline referenced
measurement. The leadline was marked at the water and measured with
a fiberglass survey tape. The leadline agreed with the sonar derived
measurement with a average difference of 0.00 m and a estimated error
of 0.03 m. On July 27, 2011 (DN208) a static leadline comparison was
performed relative to the ellipsoid using similar techniques as described
above. A ellipsoid height was obtained on a fixed mark ashore using static
GPS observations. The observed ellipsoid height was transfered to the
suspended leadline using differential leveling. The logged sonar data
was processed through Caris using standard ellipsoid methods to yield
a ellipsoid referenced measurement. The ellipsoid referenced leadline
measurement was shallower than the sonar data by an average of 0.07 m
with an uncertainty of 0.06 m.
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Snippets Sonar has snippets logging capability.

A.2.2.� �eson �111

Manufacturer Reson
Model 7111
Description This sonar is mounted in a blister fairing forward on the starboard hull. 

Serial Numbers

Vessel Installed On S250

Processor s/n 1908005

Transceiver s/n n/a

Transducer s/n n/a

Receiver s/n 1409098

Projector 1 s/n 4506285

Projector 2 s/n None

Specifications

Frequency 100 kilohertz

Along Track 1.9 degrees
Beamwidth

Across Track 1.5 degrees

Max Ping Rate 20 hertz

Beam Spacing
Mode Equidistant 

Beam Spacing
Number of
Beams 301

Max Swath Width 150 degrees

Depth Resolution 3 centimeters

Manufacturer
Specified 1000 meters 

Depth Rating
Ship Usage 700 meters

Manufacturer
Calibrations Manufacturer calibration was not performed.
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System Accuracy
Tests

Vessel Installed On S250

Methods Lead line comparison and reference surface.

Results

The 7111 was compared with both ellipsoid and waterline referenced lead
line measurements as described above. The comparisons were done on
August 5, 2011 (DN217). The depths from the 7111 were 0.44m deeper
than the ellipsoid referenced lead line (0.08 uncertainty) and 0.33 m
deeper than the waterline referenced lead line (0.08 uncertainty). On July
6, 2011 (DN187) a reference surface was acquired with both the dual head
7125 and the 7111. Both surfaces were referenced to the ellipsoid. The
depths from the 7111 were 0.4 m deeper (0.4 standard deviation) than the
7125 depths. The apparent bottom detection bias of the 7111 has been
acknowledged by Reson and verified in other systems. This offset has not
been corrected for in the vessel configuration file. All 7111 data acquired
in 2011 was in deep water.

Snippets Sonar has snippets logging capability.

Figure 5: 7111 mount and fairing. Sonar is located forward on staboard hull. 

Figure 6: Histogram of depth differences from reference surface comparison with dual-head 7125. Depths
from the 7111 are 0.4 meters deeper than the depths from the 7125s with a 0.4 meter standard deviation. 
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A.2.� Single �eam Echosounders

A.2.�.1 �dom ���200

Manufacturer Odom
Model CV-200

Description

Dual-frequency digital recording echosounder system with a digital recorder on both
 hulls.  The high frequency band is tunable from 100kHz to 1 MHz.  The low band is
 tunable from 10-50 kHz.  The installed Airmar M42 transducers are not broadband
 however and the sonar is tuned to the operating frequency of the dual-frequency
 transducers installed.  Each transducer can be operated either at 24 or 200kHz.  The
 system is configured with the low frequency signal to the port transducer and the
 high frequency signal to the starboard system to permit simultaneous, dual frequency
 acquisition.    The starboard POS system is used for positioning of the singlebeam
 and the starboard POS serves as the reference point for both transducers. 

Serial Numbers
Vessel S250

Processor s/n 3038

Transducer s/n unknown

Specifications

Frequency 200 kilohertz 24 kilohertz

Along Track 4 degrees Along Track 20 degrees
Beamwidth

Across Track 4 degrees Across Track 20 degrees

Max Ping Rate 100 kilohertz 100 kilohertz

Depth Resolution 0.01 meters 0.01 meters

Manufacturer
Specified

200 meters
Manufacturer
Specified

6000 meters
Depth Rating

Ship Usage 50 meters Ship Usage 700 meters

Manufacturer
Calibrations Manufacturer calibration was not performed.

System Accuracy
Tests System accuracy test was not performed.
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Figure 6: Hull mounted Odom Vertical Beam Echosounder

A.2.� �hase � easuring �ath�metric Sonars

No phase measuring bathymetric sonars were utilized for data acquisition.

A.2.5 �ther Echosounders

No additional echosounders were utilized for data acquisition.

A.� � anual Sounding Equipment

A.�.1 �i�er �epth �auges

No diver depth gauges were utilized for data acquisition.

A.�.2 �ead �ines

Manufacturer Unknown
Model Traditional

Description Vessel is equipped with a hand lead line. The lead line is configured with a
 removable mud shoe to limit penetration in soft bottoms. Lead lines are used for
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 system accuracy checks and measurements of depths in near shore or shallow areas
 that are impractical for other techniques.  For all use in 2011, the leadline was
 marked with tape for each measurement and the measurements then determined with
 a fiberglass tape.  The permanent markings on the leadline were neither calibrated
 nor used.   

Serial Numbers RA6S

Calibrations No calibrations were performed.
Accuracy Checks No accuracy checks were performed.
Correctors Correctors were not determined.
Non-Standard
Procedures Non-standard procedures were not utilized.

Figure 7: Leadline with removable "mud-shoe"

A.�.� Sounding �oles

No sounding poles were utilized for data acquisition.

A.�.� �ther � anual Sounding Equipment

No additional manual sounding equipment was utilized for data acquisition.

A.� �ositioning and Attitude Equipment



2011 DAPR Version 1.0           NOAA Ship Ferdinand R. Hassler         

�3

A.�.1 Applani� ��S�� �

Manufacturer Applanix
Model POS/MV 320 V4

Description

Tightly coupled GPS and inertial positioning and attitude sensing system for port
 hull.  Inertial motion unit (IMU) is located below water line close to the port side
 7125 wet end.  GPS antennae are located on flying bridge of S250.  GPS antennae
 are used for position input as well as aiding the heading solution.  The antennae pair
 for the port system is the aft pair of antennae.  The separation distance between the
 antennae is approximately 8 meters.  This distance is far above the recommended
 separation distance of 2 meters and some difficulties with the GPS aided heading
 (GAMS) solution were observed throughout 2011.  The antennae configuration was
 changed in 2012.   

PCS

Manufacturer Applanix

Model POS/MV 320 V4

Description Rack mounted POS control system located in charting lab.

Firmware Version 3.37

Software Version 5.1.0.2

Serial Numbers

Vessel Installed
On

S250 (port hull)

PCS s/n 3187

IMU

Manufacturer Applanix

Model LN200

Description
Inertial measurement system consisting of three orthogonal
accelerometers and three orthogonal fiber-optic gyroscopes. Located in
port hull near 7125 wet end.

Serial Numbers

Vessel Installed
On

S250 (port hull)

IMU s/n 804

Certification
IMU s/n 804

Certification Date 2011-06-16
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Antennas

Manufacturer Trimble

Model Zepher I

Description

Serial Numbers

Vessel Installed
On

S250 (aft pair of antennae) S250 (aft pair of antennae)

Antenna s/n 60244128 60243869

Port or
Starboard

Port Starboard

Primary or
Secondary

Primary Secondary

GAMS Calibration
Vessel S250

Calibration Date 2011-05-31

Configuration
Reports

Vessel S250

Report Date 2011-06-16

Manufacturer Applanix
Model POS MV Version 4

Description

Tightly coupled GPS and inertial positioning and attitude sensing system for
 starboard hull.  Inertial motion unit (IMU) is located below water line close to the
 starboard side 7125 wet end.  GPS antennae are located on flying bridge of S250.
  GPS antennae are used for position input as well as aiding the heading solution.
  The antennae pair for the starboard system is the forward pair of antennae.  The
 separation distance between the antennae is approximately 8 meters.  This distance
 is far above the recommended separation distance of 2 meters and some difficulties
 with the GPS aided heading (GAMS) solution were observed throughout 2011.  The
 antennae configuration was changed in 2012.   
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PCS

Manufacturer Applanix

Model POS MV Version 4

Description Rack mounted POS control system located in charting lab.

Firmware Version 3.37

Software Version 5.1.0.2

Serial Numbers

Vessel Installed
On

S250 (starboard hull)

PCS s/n 3189

IMU

Manufacturer Applanix

Model LN200

Description
Inertial measurement system consisting of three orthogonal
accelerometers and three orthogonal fiber-optic gyroscopes. Located in
starboard hull near 7125 wet end.

Serial Numbers

Vessel Installed
On

S250 (starboard hull)

IMU s/n 803

Certification
IMU s/n 803

Certification Date 2011-09-26

Antennas

Manufacturer Trimble

Model Zepher I

Description

Serial Numbers

Vessel Installed
On

S250 (forward pair of
antennae)

S250 (forward pair of
antennae)

Antenna s/n 60240385 60243047

Port or
Starboard

Port Starboard

Primary or
Secondary

Primary Secondary

GAMS Calibration
Vessel S250 Starboard

Calibration Date 2011-05-31

Configuration
Reports

Vessel S250

Report Date 2011-09-26
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A.�.2 ���S

Description Hemisphere PGS MBX DGPS receiver.  DGPS receiver feeds differential corrector
 to port and starboard POS-MV systems.  

Antennas

Manufacturer Hemisphere

Model MBX-4

Description

Serial Numbers
Vessel Installed On S250

Antenna s/n 1113139440044

Receivers

Manufacturer Hemisphere

Model MBX-4

Description

Firmware Version 1.0

Serial Numbers
Vessel Installed On S250

Antenna s/n 1118144550001

A.�.� �rim�le �ac�pac�s

Trimble backpack equipment was not utilized for data acquisition.

A.�.� �aser �ange�inders

No laser rangefinders were utilized for data acquisition.

A.�.5 �ther �ositioning and Attitude Equipment

No additional positioning and attitude equipment was utilized for data acquisition.
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A.5 Sound Speed Equipment

A.5.1 Sound Speed �ro�iles

A.5.1.1 ��� �ro�ilers

A.5.1.1.1 Sea��ird Sea�at 1�

Manufacturer Sea-Bird
Model SeaCat 19
Description Internal logging conductivity, temperature, and depth measuring device.   

Serial Numbers
Vessel Installed On S250

CTD s/n 1060

Calibrations
CTD s/n 1060

Date 2011-03-28

Procedures Routine Calibration Service
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Figure 8: SBE 19 CTD cast in protective cage

A.5.1.2 Sound Speed �ro�ilers

A.5.1.2.1 �roo�e �cean � ����0

Manufacturer Brooke Ocean
Model MVP-30

Description moving vessel profiler equipped with a AML Micro-CTD in a single sensor free fall
 fish.  

Serial Numbers
Vessel Installed On S250

Sound Speed Profiler s/n 10796

Calibrations
Sound Speed Profiler s/n 007760

Date 2009-10-21

Procedures Calibrated conductivity, pressure, and temperature.
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Figure 9: MVP control station & winch

Figure 10: MVP single sensor free fall fish 

A.5.2 Sur�ace Sound Speed
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A.5.2.1 Sea��ird �5 �icro�S�

Manufacturer Sea-Bird
Model 45 MicroTSG

Description

Two SBE-45 thermosalinographs are installed to determine the sound velocity of
 the water at the sonar transducers.  This data is used to aid beam steering of the
 multibeam sonar systems.  One is located in the starboard engine room, the other in
 the port.  Both units draw sampling water from the main cooling water line of the
 respective main engine.  A SBE-38 remote temperature sensor is integrated with
 each device.  However the SBE-38's are located in forward vent tubes that do not
 have water flow and so do not accurately reflect the ambient water temperature. 
 The SBE-45 are configured to use their internal temperature sensors and disregard
 the data from the remote temperature sensors.  The starboard SBE-45 is insulated
 with fiberglass and reflective aluminum insulation.  This device calculates the sound
 speed from the measured salinity and temperature (using the Chen-Millero equation)
 of the sampled water. A serial broadcast device sends the sound speed message from
 the SBE-45 to the port and starboard 7125 systems and the 7111.  The port SBE-45
 is not insulated and is not used for data aquisition.  

Serial Numbers
Vessel Installed On S250 Port S250 Stbd

Sound Speed Sensor s/n 4553332-0276 4553332-0277

Calibrations
Sound Speed Sensor s/n 4553332-0276 4553332-0277

Date 2009-02-15 2009-02-15

Procedures Standard calibration procedures Standard calibration procedures

A.� �ori�ontal and �ertical �ontrol Equipment

A.�.1 �ori�ontal �ontrol Equipment

No horizontal control equipment was utilized for data acquisition.

A.�.2 �ertical �ontrol Equipment

No vertical control equipment was utilized for data acquisition.

A.� �omputer �ard�are and So�t�are
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A.�.1 �omputer �ard�are

Manufacturer Dell
Model T3400
Description Processing and Acquisition Computers  

Serial Numbers

Computer s/n

FH-
PROC1
Service
Tag #
1PKVTK1

FH-
PROC2
Service
Tag #
3PSUTK1

FH-
PROC3
Service
Tag #
4P5VTK1

FH-
PROC4
Service
Tag #
2P5VPK1

FH-ACQ1
Service
Tag #
101WTK1

FH-ACQ2
Service
Tag #
201WTK1

Operating System Windows
XP

Windows
XP

Windows
XP

Windows
XP

Windows
XP

Windows
XP

Use Processing Processing Processing Processing Acquisition Acquisition

Manufacturer Cybertron PC
Model Generic
Description Processing Computer 

Serial Numbers
Computer s/n FH-PROC5 Service Tag # FQC-00765

Operating System Windows 7

Use Processing

A.�.2 �omputer So�t�are

Manufacturer CARIS
Software Name HIPS/SIPS
Version 7.1
Service Pack 0
Hotfix 2
Installation Date 2011-07-06
Use Processing
Description Data conversion and processing

Manufacturer CARIS
Software Name HIPS/SIPS
Version 7.1
Service Pack 1
Hotfix 1
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Installation Date 2012-04-02
Use Processing
Description Data processing

Manufacturer CARIS
Software Name Bathy Data Base Editor
Version 3.2
Service Pack 0
Hotfix 1
Installation Date 2011-09-23
Use Processing
Description Data analysis and feature management

Manufacturer Applanix
Software Name POSPac
Version 5.4
Service Pack 1
Hotfix
Installation Date 2011-04-05
Use Acquisition and Processing
Description Position and Attitude processing software

Manufacturer NOAA
Software Name Pydro
Version 11.11
Service Pack r3746
Hotfix
Installation Date 2011-09-27
Use Processing
Description Feature management, correlation, and report generator

Manufacturer Pitney Bowes
Software Name MapInfo
Version 10.5
Service Pack
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Hotfix
Installation Date 2011-08-24
Use Acquisition and Processing
Description GIS software

Manufacturer QPS 3D
Software Name Fledermaus
Version 7.3.2b - 64bit
Service Pack Build 406
Hotfix
Installation Date 2011-08-08
Use Processing
Description Data modeling, visualization, and backscatter processing

Manufacturer Hypack
Software Name Hypack/Hysweep
Version 11
Service Pack
Hotfix
Installation Date 2011-03-16
Use Acquisition
Description Data logging

Manufacturer Klein
Software Name SonarPro
Version 11.2
Service Pack
Hotfix
Installation Date 2011-07-11
Use Acquisition
Description Side Scan control

Manufacturer Applanix
Software Name POSView
Version 5.1.0.2
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Service Pack
Hotfix
Installation Date 2011-04-05
Use Acquisition
Description Positioning

Manufacturer Synergy
Software Name Synergy
Version 1.3.6
Service Pack
Hotfix
Installation Date 2011-05-10
Use Acquisition
Description Shared mouse and keyboard between acquisition systems

Manufacturer CARIS
Software Name PlotComposer
Version 5.2
Service Pack
Hotfix
Installation Date 2012-06-06
Use Processing
Description Generation of plots and public relations deliverables.

A.� �ottom Sampling Equipment

A.�.1 �ottom Samplers

A.�.1.1 �onar � ildco 1�2�

Manufacturer Ponar Wildco
Model 1728
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Description Grab sampler triggered by contact with sea floor.  

Figure 11: Ponar Grab Sampler

� �ualit� �ontrol

B.1 Data Acquisition

B.1.1 Bathymetry

B.1.1.1 Multibeam Echosounder

Multibeam data are acquired in through Hypack/Hysweep in HSX format for bathymetry.  Multibeam
 data and are also logged locally on the Reson topside machines in s7k format. The HSX format includes
 sounding solutions, navigation, and attitude data.  The s7k format includes sounding solutions, navigation,
 attitude and backscatter snippet data.  This record included Reson datagrams: 1003, 1012, 1012, 7000,
 7004, 7006, 7008, 7011, 7503.  The Hypack logged .7k snippet backscatter record is not available for the
 dual head 7125 configuration.  Ship navigation and survey line monitoring are performed with Hypack/
 Hysweep.
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The Reson units are interfaced with the acquisition machines through UDP LAN connections over a
 dedicated network switch (Netgear ProSafe Gigabit Switch).  Position and attitude data is passed from the
 POS-MV to both the Reson machines and to the acquisition computers through dedicated network switches
 (NetGear ProSafe Gigabit switch).  There is a decicated switch for the port and starbord POS systems. 
 Time is passed from the POS to the Reson machines via a RS232 serial connection.  The starboard POS is
 interfaced with the starboard 7125 and the 7111, which is located in the starboard hull.  The port POS is
 interfaced to the port 7125.  

Surface sound speed from the starboard TSG-45 is fed into all Reson machines via RS232 serial
 connections. 

In the dual head 7125 configuration, the port 7125 is configured as the master and the starboard unit the
 slave.  Pinging is alternated between the two heads to avoid interference.  The Hypack logged HSX file in
 this configuration contains sounding data from both heads with the navigation and attitude data from the
 starboard POS-MV.      

B.1.1.� �in�le Beam Echosounder

Single beam echosounder bathymetry was not acquired.

B.1.1.� �hase Measurin� Bathymetric �onar

Phase measuring bathymetric sonar bathymetry was not acquired.

B.1.� �ma�ery

B.1.�.1 �ide �can �onar

The side scan fish is towed from a block suspended from the A-frame on the stern of the vessel .  The height
 of the fish above the sea floor is actively managed  through use of the remote winch control.  Side scan
 imagery is monitored and logged using SonarPro.  Tow cable offset values are entered into SonarPro to
 account for cable out in the docked tow position.  This position has 12 m of cable between the tow point and
 the fish.  

Survey lines are pre-planned to achieve coverage required by the project instruction.  These lines are planned
 in MapInfo and exported to Hypack.  Hypack is used for ship navigation and for survey line tracking. 

B.1.�.� �hase Measurin� Bathymetric �onar

Phase measuring bathymetric sonar imagery was not acquired.

B.1.� �ound ��eed
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B.1.�.1 �ound ��eed �ro�iles

Seabird SBE 19 and MVP sound speed profilers are used regularly to collect sound speed data for ray tracing
 corrections for the multibeam sonar systems.  In shallow water, the SBE 19 is hand deployed from the
 stern.  In deeper water the oceanographic winch is used.  Data is retrieved from the SBE 19 with a serial
 connection to an acquisition computer.  Data from both the SBE 19 and MVP are processed through the
 NOAA in-house program Velocipy to give Caris .SVP formatted sound velocity profiles.  All svp profiles
 for a survey sheet are concatenated to one master file for a survey.  

Casts are taken at least every four hours.  Cast frequency is increased in areas with strong sound speed
 gradients or anticipated sound speed variability.  Cast locations are spread through the survey area to best
 capture the variability and are typically oversampled when using the MVP.

Figure 12: Example of sound speed samples taken in a survey area

B.1.�.� �ur�ace �ound ��eed

The starboard Seabird TSG 45 thermosalinograph is used for determination of surface sound speed.   This
 unit is located in the starboard main engine room and draws water from the raw water cooling line of the
 main engine.  The port TSG-45 data is not used because the unit is uninsulated and reads erroneously high
 seawater temperatures.  The starboard TSG and associated plumbing is insulated  This device calculates the
 sound speed from the measured salinity and temperature (using the Chen-Millero equation) of the sampled
 water.  A serial broadcast device sends the sound speed message from the SBE-45 to the port and starboard
 7125 systems and the 7111.  Other than the records in the logged multibeam data files, the surface sound
 speed is not logged.

B.1.� �ori�ontal and �ertical �ontrol

B.1.�.1 �ori�ontal �ontrol
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During acquisition, the port and starboard POS-MV units output position and attitude data through dedicated
 network switches (Netgear ProSafe Gigabit Switch) to both the acquisition computers and the sonar
 systems. 

Applanix POS/MV .000 files are logged to the acquisition machine which contain attitude, heading, position
 and velocity data compliant with section 3.4.1 of the FPM.  During acquisition, the navigation solution
 status status is constantly monitored by the acquisition watch stander. 

Real-time USCG DGPS correctors are used for all acquisition.  Specific DGPS stations are noted in the
 Descriptive Reports accompanying each survey.

B.1.�.� �ertical �ontrol

Preliminary, observed and verified water levels are downloaded using FetchTides and applied to the data
 using CARIS HIPS Load Tide function.  Refer to individual survey Descriptive Reports for detail. 

B.1.� �eature �eri�ication

Feature verification followed guidelines set forth in section 3.5.5 of the FPM.  Refer to individual sheet DRs
 for additional information if differing from previously stated.

B.1.� Bottom �am�lin�

Bottom Sampling followed guidelines set forth in sections 7.1 of the HSSD and 2.5.4.2.1 of the FPM.  Refer
 to individual sheet DRs for additional information if differing from previously stated.

B.1.� Bac�scatter

Backscatter is acquired in the 7008 record logged in the .s7k files directly from the Reson 7125 processors.
  For processing, this record is paired with a GSF file exported from CARIS containing processed depth
 information.  The paired files are imported into QPS Fledermaus Geocoder Toolbox for mosaic processing. 
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B.1.� �ther

No additional data were acquired.

Additional Discussion

Ferdinand Hassler maintains a continuous manned survey watch during all survey acquisition.  The watch
 stander is in constant communication with the bridge and monitors the performance of all systems. 
 Thresholds set in Hypack/Hysweep, POS view, Reson and Sonar Pro alert the watch stander by displaying
 alarm messages when error thresholds or tolerances are exceeded.  Alarm conditions that may compromise
 survey data quality are corrected and then noted in acquisition log.  Warning messages such as the
 temporary loss of differential GPS, excessive cross track error, or vessel speed approaching the maximum
 allowable survey speed are addressed by the watch stander and corrected before further data acquisition
 occurs.

B.� Data �rocessin�

B.�.1 Bathymetry

B.�.1.1 Multibeam Echosounder

Bathymetry processing followed section 4.2 of the FPM unless otherwise noted.

Raw .hsx multibeam data are converted to CARIS HIPS HDCS format.  TrueHeave, sound speed and water
 level correctors are applied to all lines and the data is merged.  Total Propagated Uncertainty (TPU) is
 computed using settings documented for each survey in the descriptive report. 

The general resolution, depth ranges, and Combined Uncertainty and Bathymetric Estimator (CUBE)
 parameter settings outlined in section 5.2.2.2 of the HSSD and section 4.2.1.1.1.1 of the FPM are used for
 surface creation and analysis.  A detailed listing of the resolutions and the actual depth ranges used during
 the processing of each survey, along with the corresponding fieldsheet(s), is provided in the Descriptive
 Report of each survey.

BASE surfaces are created using the CUBE algorithm and parameters contained in the NOAA
 CUBEParams_NOAA.xml file as provided in Appendix 4 of the FPM.  The CUBEParams_NOAA.xml
 file will be included with the HIPS Vessel Files with the individual survey data.  The NOAA parameter
 configurations for resolutions 0.5-32 meters are used.

Multibeam data are reviewed and edited in HIPS swath editor and in subset mode as necessary.  The
 finalized BASE surfaces and CUBE hypotheses are used for directed data editing at the appropriate depth
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 range in subset editor.  The surfaces and subset editor view are also used to demonstrate coverage and to
 check for errors due to tides, sound speed, attitude and timing.

Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and attitude editor
 if deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in heading, attitude, or
 navigation data are manually rejected or interpolated for small periods of time.  Any such editing is detailed
 in the survey Descriptive Report.

The Density method for hypothesis disambiguation is used.

The surface filtering function in CARIS HIPS is not utilized routinely. 

In depths less than 20 meters and deeper in areas of navigational significance where the BASE surface does
 not depict the desired depth for the given area, a designated sounding is selected.  Designated soundings are
 selected as outlined in section 5.2.1.2 of the HSSD.

IHO child layers are created using the following two formulas for IHO_1 and IHO_2, respectively; -
Uncertainty/((0.5^2 +((Depth*0.013)^2))^0.5) and -Uncertainty/((1.0^2 +((Depth*0.023)^2))^0.5).  IHO_1
 is created for all soundings less than 100 meters while IHO_2 is for 100 meters and deeper.  This layer
 is then exported and run through an application which computes statistics.  The results are reported and
 analyzed in each sheets individual DR.

Additionally, a combined surface is reviewed in 3-D mode using one of the following programs; CARIS
 HIPS, CARIS Base Editor or IVS Fledermaus, to ensure that the data are reasonable models of the sea floor
 and do not contain any fliers.

Figure 13: MBES flow diagram

B.�.1.� �in�le Beam Echosounder

Single beam echosounders were not utilized during the 2011 field season other than for testing purposes.
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Figure 14: VBES flow diagram

B.�.1.� �hase Measurin� Bathymetric �onar

Phase measuring bathymetric sonar bathymetry was not processed.

B.�.1.� ��eci�ic Data �rocessin� Methods

B.�.1.�.1 Methods �sed to Maintain Data �nte�rity

The use of processing logs to record and communicate problems from acquisition to final processing.

B.�.1.�.� Methods �sed to �enerate Bathymetric �rids

All methods used to generate final bathymetric grids are followed as put forth in section 4.2 and all relevant
 subsections of the FPM.

B.�.1.�.� Methods �sed to Deri�e �inal De�ths

Methods Used
Cleaning Filters
Gridding Parameters
Surface Computation Algorithms

Description Filters are used on a case by case basis as determined by the hydrographer, refer to
individual sheet DRs for more information.
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B.�.� �ma�ery

B.�.�.1 �ide �can �onar

Side scan sonar data are converted from .sdf (Sonarpro raw format) to CARIS HDCS lines.  Fish height,
 vessel heading, and vessel navigation records are reviewed for each file and edited as necessary.  Tow point
 offsets (A-Frame and cable out), fish depth, fish attitude and water depth are used to calculate horizontal lay
 back.  Fish navigation is recalculated using CARIS SIPS.

After towfish navigation is recalculated, side scan imagery data are slant-range corrected and closely
 examined for targets.  Targets are selected and saved as contacts to a contact file for each line of SSS data.
  Contact selection includes measuring apparent height and width, selecting contact position and creating a
 contact snapshot image.  Targets are exported to Pydro for correlation and processing.  Significant targets
 are surveyed with MBES to obtain least depths. 

Side scan sonar coverage is determined by creating mosaics using Mosaic Editor in CARIS SIPS.  This
 processed imagery data is stored in SIPS as Georeferenced Backscatter Rasters, or GeoBaRs.  From
 GeoBaRs, mosaics are created which can be examined and edited in Mosaic Editor.  

Figure 15: SSS flow diagram

B.�.�.� �hase Measurin� Bathymetric �onar

Phase measuring bathymetric sonar imagery was not processed.

B.�.�.� ��eci�ic Data �rocessin� Methods
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B.�.�.�.1 Methods �sed to Maintain Data �nte�rity

The use of processing logs to record and communicate problems from acquisition to final processing.

B.�.�.�.� Methods �sed to Achie�e �b�ect Detection and Accuracy �equirements

Range of the SSS, XTE, speed of vessel collecting data and repetitious processing examinations are all used
 to ensure that object detection and accuracy requirements are met.

B.�.�.�.� Methods �sed to �eri�y ��ath �o�era�e

Swath coverage is verified through construction of side scan mosaics.  During acquisition, the outer portions
 of the swath are monitored for refraction artifacts.  If an apparent refraction artifact impacts objects
 detection ability and cannot be eliminated through adjustment of fish height, the range scale is reduced. 

B.�.�.�.� �riteria �sed �or �ontact �election

Contacts are selected it the apparent shadow measures greater than 1.0 meters or if the contact might
 otherwise be navigationally significant.

B.�.�.�.� �om�ression Methods �sed �or �e�ie�in� �ma�ery

No compression methods were used for reviewing imagery.

B.�.� �ound ��eed

B.�.�.1 �ound ��eed �ro�iles

CTD profiles from both the Seabird SBE 19 and the AML Micro-CTD installed in the MVP system are
 processed using the NOAA developed program Velocipy.  From each system, sound speed profiles are
 extracted and archived as both individual and concatenated Caris SVP files.  

B.�.�.1.1 ��eci�ic Data �rocessin� Methods

B.�.�.1.1.1 �aris ��� �ile �oncatenation Methods

All sound speed profiles for a survey sheet are concatenated into one master file. 

Figure 99: no figure
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B.�.�.� �ur�ace �ound ��eed

Surface sound speed data were not processed.

B.�.� �ori�ontal and �ertical �ontrol

B.�.�.1 �ori�ontal �ontrol

Fixed USCG DGPS stations are used for all real time horizontal control.  If post-processed GPS techniques
 are used to improve horizontal control, specific information is included in the Descriptive Report.  

Figure 99: no figure

B.�.�.� �ertical �ontrol

CO-OPS zoned water levels utilizing water level observations from fixed, continuously operating NOAA
 tide gages are used for reduction of data to MLLW.  Predicted water levels are applied during preliminary
 processing.  Before submission, verified water levels are applied to all tidally corrected data.  If post-
processed GPS techniques are used to improve horizontal control, specific information is included in the
 Descriptive Report.  

Figure 99: no figure

B.�.� �eature �eri�ication

Features are processed using NOAA's Pydro software and are included with submitted processed data in the
 survey's final feature file (FFF).  The FFF includes all features; buoys, rocks, wrecks, bottom samples, etc.,
 addressed within the limits of each individual sheet.
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Figure 99: no figure

B.�.� Bac�scatter

All backscatter was processed from acquired Reson .s7k files.  Processed bathymetry is exported from
 Caris in GSF format, paired with the .s7k file in the raw data directory, and imported into QPS Fledermaus
 Geocoder Toolbox.  A mosaic is processed with default processing parameters.  Reson TVG plugins are
 used for all processing steps.

Figure 99: no figure

B.�.� �ther

No additional data were processed.

B.� �uality Mana�ement

Standard operating procedures (SOPs) and checklists are followed by personnel throughout the survey to
 ensure consistent high quality data and products.  

Data is constantly reviewed for quality during acquisition and processing by all personnel.  Before any data
 is to be submitted it is reviewed independently by at least three experienced persons who are signatories to
 the Descriptive Report. 

B.� �ncertainty and Error Mana�ement

Error values for the multibeam and positioning systems were compiled from manufacturer specifications
 sheets for each sensor and from values set forth in section 4.2.3.8 and Appendix 4 - CARIS HVF
 Uncertainty Values of the 2011 FPM.
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Regardless of this document stating that TPU was not calculated, TPU was calculated, but individual
 uncertainty values are not included here to reduce duplication.  Refer to individually submitted HVF files
 for Uncertainty values used.

B.�.1 �otal �ro�a�ated �ncertainty �����

Total propagated uncertainty was not calculated.

B.�.� De�iations

There were no deviations from the requirement to compute total propagated uncertainty.

� �orrections �o Echo �oundin�s

�.1 �essel ���sets and �aybac�

�.1.1 �essel ���sets

�.1.1.1 Descri�tion o� �orrectors

�.1.1.� Methods and �rocedures

Sensor offsets are measured with respect to the vessel's reference point.  These offsets are derived from the
 full survey performed in the shipyard, a partial survey performed by NGS and measurements / verifications
 performed by Ferdinand R. Hassler personnel.  All necessary offsets are tracked and updated as needed on a
 spreadsheet to be submitted with the appendices of this report.  

The port IMU serves as the reference point for the port-only 7125 configuration and the side scan sonar.  For
 all other vessel configurations the starboard IMU is the reference point.

�.1.1.� �essel ���set �orrectors

Vessel S250 Port
Echosounder Reson 7125 400 kilohertz
Date 2011-07-20
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Offsets

MRU to Transducer

x -1.244 meters

y 0.362 meters

z 1.486 meters

x2  

y2  

z2  

Nav to Transducer

x -2.294 meters

y -1.033 meters

z 14.234 meters

x2  

y2  

z2  

Transducer Roll
Roll 4.5 degrees

Roll2  

Vessel S250 Starboard
Echosounder Reson 7125 400 kilohertz
Date 2011-07-26

Offsets

MRU to Transducer

x 1.424 meters

y 0.380 meters

z 1.493 meters

x2  

y2  

z2  

Nav to Transducer

x 12.623 meters

y -1.549 meters

z 14.233 meters

x2  

y2  

z2  

Transducer Roll
Roll -4.5 degrees

Roll2  

Vessel S250 Dual
Echosounder Reson 7125 400 kilohertz
Date 2011-09-09
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Offsets

MRU to Transducer

x -13.490 meters

y 0.338 meters

z 1.485 meters

x2 1.424 meters

y2 0.380 meters

z2 1.493 meters

Nav to Transducer

x -2.291 meters

y -1.591 meters

z 14.225 meters

x2 12.623 meters

y2 -1.549 meters

z2 14.233 meters

Transducer Roll
Roll 4.5 degrees

Roll2 -4.5 degrees

Vessel S250
Echosounder Reson 7111 100 kilohertz
Date 2011-07-20

Offsets

MRU to Transducer

x 1.203 meters

y 11.678 meters

z 1.180 meters

x2  

y2  

z2  

Nav to Transducer

x 12.402 meters

y 9.749 meters

z 13.920 meters

x2  

y2  

z2  

Transducer Roll
Roll 0.000 degrees

Roll2  

Vessel S250
Echosounder Odom Echotrac CV200 24 kilohertz
Date 2012-05-01
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Offsets

MRU to Transducer

x -0.455 meters

y 4.620 meters

z 1.325 meters

x2 -12.701 meters

y2 4.62 meters

z2 1.325 feet

Nav to Transducer

x 12.623 meters

y -1.549 meters

z 14.233 meters

x2  

y2  

z2  

Transducer Roll
Roll 0.000 degrees

Roll2  

�.1.� �aybac�

�.1.�.1 Descri�tion o� �orrectors

Layback is calculated in Caris from the cable-out and fish depth.  Cable-out is output from a cable counter
 and recorded in the .sdf file.  A 12 meter offset is applied in Sonar Pro to account for the amount of cable
 out when the towfish is in the docked position.  The side scan cable is marked at 12 meters and is deployed
 to this position on launching.  The cable counter is reset to zero at this position and the 12 meter offset
 applied in SonarPro.  Thus the cable out value in the .sdf file is the correct value for the cable between the
 tow point and the towfish.  The port POS system is used for positioning of the side scan.  The port IMU is
 the reference point for offsets. 

�.1.�.� Methods and �rocedures

Layback was calculated from the side scan calibration performed prior of obtaining data.

�.1.�.� �aybac� �orrectors

Vessel S250
Echosounder Klein 5000 455 kilohertz
Date 2011-05-26

Layback
Towpoint

x 7.161 meters

y -26.032 meters

z -9.347 meters

Layback Error 0 meters
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�.� �tatic and Dynamic Dra�t

�.�.1 �tatic Dra�t

�.�.1.1 Descri�tion o� �orrectors

Because of her SWATH design HASSLER is particularly susceptible to loading and trim. While underway,
 the ballast is actively managed to maintain the draft at the design draft of 3.85 meters.   During typical
 survey operations, HASSLER burns approximately 4,000 liters of diesel per day.  At a density of 0.83
 kilograms/ liter this is approximately 3.3 metric tons of fuel per day.  At design draft of 3.85 meters, 1.3
 metric tons is required to submerge an additional 0.01 meters of the hull in salt water.  The daily fuel burn
 would thus account for 0.03 meters of variation in the draft.  Ballast is adjusted daily to account for fuel
 burn and the levels in other tanks.  Uncertainty is conservatively estimated at 0.05 meters. 

�.�.1.� Methods and �rocedures

The waterline to reference point is calculated from the vessel offset survey and the vessel draft marks.  

�.�.� Dynamic Dra�t

�.�.�.1 Descri�tion o� �orrectors

�.�.�.� Methods and �rocedures

An ellipsoidally referenced DDM was performed following guidelines put forth in the field procedures
 manual.

For a complete list of the dynamic draft please refer to attached ERDDM_Summary or appropriate HVF.

�.�.�.� Dynamic Dra�t �orrectors

Vessel S250
Date 2011-05-01

Dynamic
Draft Table

Speed 0 meters/second

Draft 0 meters

�.� �ystem Ali�nment
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�.�.1 Descri�tion o� �orrectors

�.�.� Methods and �rocedures

Methods and Procedures used follow recommendations given in section 1.5 of the 2011 FPM.

�.�.� �ystem Ali�nment �orrectors

Vessel S250
Echosounder Reson 7125 Starboard 400 kilohertz
Date 2011-07-07

Patch Test Values

Navigation Time
Correction 0.00 seconds

Pitch 0.07 degrees

Roll -0.06 degrees

Yaw 0.67 degrees

Pitch Time Correction 0.00 seconds

Roll Time Correction 0.00 seconds

Yaw Time Correction 0.00 seconds

Heave Time Correction 0.00 seconds

Vessel S250
Echosounder Reson 7125 Port 400 kilohertz
Date 2011-07-07

Patch Test Values

Navigation Time
Correction 0.00 seconds

Pitch 0.27 degrees

Roll -0.08 degrees

Yaw -0.59 degrees

Pitch Time Correction 0.00 seconds

Roll Time Correction 0.00 seconds

Yaw Time Correction 0.00 seconds

Heave Time Correction 0.00 seconds

Vessel S250
Echosounder Reson 7111 100 kilohertz
Date 2011-06-07



2011 DAPR Version 1.0           NOAA Ship Ferdinand R. Hassler         

�2

Patch Test Values

Navigation Time
Correction 0.00 seconds

Pitch 0.00 degrees

Roll -0.05 degrees

Yaw 0.26 degrees

Pitch Time Correction 0.00 seconds

Roll Time Correction 0.00 seconds

Yaw Time Correction 0.00 seconds

Heave Time Correction 0.00 seconds

�.� �ositionin� and Attitude

�.�.1 Descri�tion o� �orrectors

�.�.� Methods and �rocedures

Vessel attitude is measured by the POS/MV and recorded in the Hysweep .hsx file.  The Reson 7111 is patch
 stabilized in real time, otherwise, attitude measurements not applied in real time are applied during post
 processing in CARIS HIPS using the raw POS/MV attitude data recorded in the Hysweep .hsx file.  When
 available, post processed kinematic (PPK) position and attitude solutions from the POS/MV .000 file are
 applied to MBES data in CARIS HIPS in the form of SBET files.

The POS/MV TrueHeave data is logged within the POS/MV .000 files and applied in CARIS HIPS during
 post processing using the "Apply TrueHeave" function.  TrueHeave is a forward-backward filtered heave
 corrector as opposed to the real time heave corrector, and is fully described in section 6 of the POS/MV V4
 User Guide 2009.

PPK data in the form of Single Best Estimate of Trajectory (SBET) files are applied to soundings to increase
 the accuracy of the kinematic vessel corrections and to allow the ability to reference soundings to the
 ellipsoid.  Standard daily data processing procedures include post processing of POS/MV kinematic .000
 files using Applanix POSPac MMS and POSGNSS software using either IN-Fusion SmartBase or IN-
Fusion SingleBase processing modes.  After processing and quality control analysis of the post-processed
 SBET files is complete. the SBET and SMRMSG files are applied to the HDCS data in CARIS HIPS using
 the "Load Attitude/Navigation Data" and "Load Error Data" processing tools.

�.� �ides and � ater �e�els

�.�.1 Descri�tion o� �orrectors

�.�.� Methods and �rocedures
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Unless otherwise noted in the survey Descriptive Report (DR) and/or project Horizontal and Vertical Control
 Report (HVCR), the vertical datum for all soundings and heights is Mean Lower Low Water (MLLW). 
 Predicted, preliminary, and/or verified water level correctors from the primary tide station(s) listed in the
 Project Instructions may be downloaded from the CO-OPS website and used for water level corrections
 during the course of the project.  These tide station files are collated to include the appropriate days of
 acquisition and then converted to CARIS .tid file format using FetchTides.

Water level data in the .tid files are applied to HDCS data in CARIS HIPS using the zone definition file
 (.zdf) or a Tidal Constituent and Residual Interpolation (TCARI) model supplied by CO-OPS.  Upon
 receiving final approved water level data, all data are reduced to MLLW using the final approved water
 levels as noted in the individual surveys DR.

A complete description of vertical control utilized for a given project can be found in the project specific
 HVCR, submitted for each project under separate cover when necessary as outlined in section 5.2.3.2.3 of
 the FPM.

Newer methods for handling vertical control are being developed and, if utilized, will be explained in more
 detail in the project wide HVCR or survey descriptive report.

�.� �ound ��eed

�.�.1 �ound ��eed �ro�iles

�.�.1.1 Descri�tion o� �orrectors

�.�.1.� Methods and �rocedures

Seabird .cnv and MVP .bot files are collected when necessary and converted to .svp files using Velocipy. 
 These .svp files are concatenated into one vessel specific master file which is then applied to HDCS data
 using a specified method.  This method of applying sound speed to data is listed in the processing log
 included in the Separates submitted with the individual survey.

�.�.� �ur�ace �ound ��eed

�.�.�.1 Descri�tion o� �orrectors

Surface sound speed output by the starboard TSG is fed to all multibeam systems via serial connections.  

�.�.�.� Methods and �rocedures



2011 DAPR Version 1.0           NOAA Ship Ferdinand R. Hassler         

��

The sound speed is monitored by the acquisition watch stander and periodically compared with the CTD or
 MVP derived values.   



D. A�����A� ��EE�

This Data Acquisition and Processing Report for project OPR-D304-FH-11, Approaches to 
Chesapeake Bay and M-H712-FH-11, Florida to North Carolina Trackline is respectfully 
submitted. 

As Chief of Party, I have ensured that standard field surveying and processing procedures were 
adhered to during these projects in accordance with the Hydrographic Surveys Specifications 
and Deliverables (4/2011), Hydrographic Survey Technical Directive HTD 2010-2, and the 
Field Procedures Manual for Hydrographic Surveying (5/2011). 

I acknowledge that all of the information contained in this report is complete and accurate to 
the best of my knowledge. 

This DAPR applies to surveys F00607, H12346 which was completed in 2011 for Project 
D304 and survey D00158 which was completed in 2011 for Project H712. 

Approved and Forwarded: 

_________________________________     _________________________________ 
LT Samuel F. Greenaway, NOAA      LCDR Benjamin K. Evans, NOAA 
Field Operations Officer       Chief of Party 

Samuel 
Greenaway

Digitally signed by Samuel Greenaway 
DN: cn=Samuel Greenaway, o=NOAA Office of 
Marine and Aviation Operations, ou=Ferdinand 
R. Hassler, 
email=samuel.greenaway@noaa.gov, c=US 
Date: 2012.07.30 13:09:53 Z

Benjamin K. Evans 
2012.07.30 09:20:37 
-04'00'
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Final report 
 
SURVEY REPORT 
 
SHIP: M286 SWATH 
FERDINAND R. HASSLER 
 
LOCATION:  PASCAGOULA, MS 
 
DATE:  7/18-7/26, 2009 
And          11/4, 2009 
 
 
PURPOSE: 
   Determine the ship’s centerline, roll, and pitch. Install benchmarks,  install the master 
reference plane in the same planes as the measured roll, pitch, and azimuth of the ship. Assist the 
shipyard to install the IMUs parallel to the centerline, and in the same plane as the ship’s roll and 
pitch. Assist the shipyard in installing the transducers in the same plane as roll, pitch and azimuth 
of the ship. Measure and spot the draft marks. 
 
PERSONNEL:   
    Eric Kostelak 
    Brian Kloter 
    Raymond Impastado 
    John Miskimmin 
     
            
 
EQUIPMENT LIST: 
      WILD T2 THEODOLITE  SN:  169786  Calibration Expiration Date; 12/19/09 
         
 
       WILD T2 THEODOLITE  SN:  155062  Calibration Expiration Date; 12/19/09 
 
       WYLER CLINO 2000 CLINOMETER  SN: M4416  Calibration Expiration 
                                                                                                         Date; 07/10/10                                                    
                                                                                                      
       TOPCON GTS-301 One Second Electronic Total Station, Serial number GU1193 
                                                                          Calibration Expiration Date; 07/12/09 
 
       WILD NA1 AUTO LEVEL: SN 472810   Calibration Expiration Date; 07/12/09 
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Procedures: 
 
       1.  Establish a baseline in relation to the centerline of both pontoons. 
               A. Locate points on each of the pontoons to determine centerline 
               B. Measure the elevation differences of the points. Take the average of  
                    these to determine the pitch and roll of each pontoon. 
                     
       2.  Take the average of the measurements of the two pontoons for roll, pitch, 
             and centerline. The result can then be used as the Master reference.  
 
       3.  Create a traverse, in a level plane, around the ship using the established 
             baseline as a reference. Set various points that will be used to locate the 
             master reference block, IMUs, bench marks, transducers, and antennas. 
 
       4.  Locate, set and secure the master reference block to within 9 arc seconds 
            of the calculated roll, pitch, and centerline values. 
 
      5. Once the MRB has set for a day, confirm the measurements relative to the  
            results of step 2. If the measurements are within the two values used in  
            Step 2, these values will become the Final Master Reference, which all  
            further measurements will be referenced to. 
 
       6.  Locate IMU foundations, adjust to be level with roll and pitch, and aligned 
            with centerline. 
 
      7.  Establish bench marks that are aligned to the centerline in any areas that require  
           future measurements. 
 
       8. For transducers, on the bottom of the hull, establish punch marks aligned to the  
           centerline that can be used to align the transducers to the centerline. 
 
      9.  Run a closed level loop from the master reference block to all bench marks, 
           Transducers, antennas, and sensors to determine their elevation values 
            relative to the reference. (Z axis). 
 
     10. Using established elevation points within the traverse, determine the correct  
            locations for all draft marks. 
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     11. Work with the shipyard to determine the correct alignment of the transducers. 
 
METHODS 
    
          All angles at intersections were turned 4 times, 2 in regular, and 2 in inverted 
          position. All other angles were turned 2 times, once in regular, and once in  
          inverted position.  
 
           
 
          Slope distances were measured with a zenith angle in the regular and inverted  
          Position. 
 
           The Traverse was closed and computed for accuracy. 
 
 

Results 
 

MRB 
After the MRB has set up for 24 hours, it was found the chock fast had caused an 18 second 
movement in roll. As this small value was well within the average of the two pontoons, the final 
reference was shifted to the MRB values. 
 
IMU 
During measurements of the IMUs, we discovered it was impossible to meet the specification to 
be level to the roll and pitch within 90 arc seconds using the existing mounts. The shipyard 
manufactured a double plate separated by three threaded rods, which allowed fine 
adjustment in two planes (roll and pitch). The IMUs were aligned to zero measurable 
azimuth error, and to within 5 arc seconds in roll and pitch relative to the MRB. 
 
TRANSDUCERS 
7125 
 During measurements it became apparent that it was impossible to meet the roll and pitch 
specification on the multibeam transducer mounts. There was no measurable azimuth error on 
either 7125 transducer mount, when the welding was finished. The shipyard came up with the 
roll and pitch solution of machining the surfaces in place once the mounting plates were 
completely welded out. We attended for the machine work on 8/19/09. A portable milling 
machine was put in place, leveled to within 5 arc seconds of the MRB plus 4.5 degrees of roll to  
Give the transducer mounting surfaces the specified 4.5 degree outward roll angle. See attached 
photo. It was agreed by all that if the milling machine was positioned correctly, the surfaces had 
to be correct, but as a check to confirm the process, we measured the machined surface on the 
port unit, and found the pitch error was zero, and the roll error was 15 seconds. This was well 
within the required 90 seconds. 
 



 5

 
Milling machine set up on 7125 transducer housing 

 
 
 
 
7111 
 
Like the 7125s, it was impossible to meet the roll and pitch specification on this transducer 
mounting plate. It too, was machined by the portable milling machine. 
The machine was set up to be within 5 seconds of the MRB Pitch and Roll values. 
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                              XYZ COORDINATES TABLE 
 

POINT X-AXIS Y-AXIS Z-AXIS DESCRIPTION 
5 9.264 -7.555 7.169 POINT FP 
6 9.409 6.256 7.168 POINT FS 
7 3.491 -7.478 7.176 POINT MP 
8 3.872 6.168 7.178 POINT MS 
9 -4.035 -7.561 7.168 POINT AP 

10 -4.022 6.258 7.169 POINT AS 
15 9.326 -0.652 7.168 CENTERLINE 
18 -4.017 -0.652 7.168 CENTERLINE 
19 16.343 2.530 -5.065 STARBOARD BENCH MARK TOP WHEEL HOUSE 
20 16.343 -0.653 -5.064 MID BENCH MARK TOP WHEEL HOUSE 
21 16.343 -3.836 -5.066 PORT BENCH MARK TOP WHEEL HOUSE 
25 -1.336 0.001 0.160 AFT BENCH MARK MASTER REFERENCE PLATE 
26 0.000 0.000 0.000 MASTER REFERENCE PLATE 
27 -0.353 0.000 0.161 FWD BENCH MARK MASTER REFERENCE PLATE 
28 13.428 -8.960 -2.496 PORT BENCH MARK BRIDGE WING 
29 13.428 -5.592 -2.476 STARBOARD BENCH MARK BRIDGE WING 
30 7.115 5.836 7.154 FWD PUNCH MARK ADCP 
31 5.765 5.835 7.145 AFT PUNCH MARK ADCP 
33 7.841 6.846 7.167 FWD PUNCH MARK RESON 7125 STARBOARD PONTOON 
34 5.025 6.847 7.168 AFT PUNCH MARK RESON 7125 STARBOARD PONTOON 
36 5.022 -8.169 7.157 AFT PUNCH MARK RESON 7125 PORT PONTOON 
37 7.792 -8.169 7.154 FWD PUNCH MARK RESON 7125 PORT PONTOON 
39 15.307 6.610 6.843 AFT PUNCH MARK RESON 7111 
40 16.098 6.611 6.771 FWD PUNCH MARK RESON 7111 
41 10.822 5.864 7.169 FWD PUNCH MARK MDS* STARBOARD PONTOON 
42 9.818 5.863 7.172 AFT PUNCH MARK MDS* STARBOARD PONTOON 
43 10.608 -7.081 7.177 FWD PUNCH MARK MDS* PORT PONTOON 
44 9.762 -7.080 7.175 AFT PUNCH MARK MDS* PORT PONTOON 
45 -13.926 -0.615 0.105 AFT MID BENCH MARK BACK DECK 
46 -9.031 -0.615 0.125 FWD BENCH MARK BACK DECK 
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POINT X-AXIS Y-AXIS Z-AXIS DESCRIPTION 

47 -13.926 6.471 0.114 STARBOARD BENCH MARK BACK DECK 
48 -13.926 -7.697 0.093 PORT BENCH MARK BACK DECK 
51 5.891 -6.878 5.839 IMU PORT PONTOON (OLD LOCATION) 
52 5.923 5.428 5.840 IMU STARBOARD PONTOON (OLD LOCATION) 
53 17.655 6.584 6.890 RESON 7111 CENTER OF PLATE 
54 6.265 6.774 7.095 PORT EDGE RESON 7125 STARBOARD PONTOON 
55 6.265 6.805 7.093 RESON 7125 STARBOARD PONTOON 
56 6.223 -8.078 7.087 STARBOARD EDGE RESON 7125 PORT PONTOON 
57 6.223 -8.109 7.085 RESON 7125 PORT PONTOON 
58 16.039 5.417 2.563 INBOARD DRAFT MARK FRAME 4 STARBOARD 
59 16.025 -6.711 2.567 INBOARD DRAFT MARK FRAME 4 PORT 
60 -11.204 5.626 2.588 INBOARD DRAFT MARK FRAME 46 STARBOARD 
61 -11.208 -6.870 2.562 INBOARD DRAFT MARK FRAME 46 PORT 
62 16.040 7.458 2.565 OUTBOARD DRAFT MARK FRAME 4 STARBOARD 
63 -11.208 7.462 2.588 OUTBOARD DRAFT MARK FRAME 46 STARBOARD 
64 16.025 -8.735 2.570 OUTBOARD DRAFT MARK FRAME 4 PORT 
65 -11.205 -8.711 2.555 OUTBOARD DRAFT MARK FRAME 46 PORT 
66 6.273 -9.907 5.789 PORT BENCH MARK IMU PORT PONTOON 
67 6.273 -5.007 5.861 STARBOARD BENCH MARK IMU PORT PONTOON 
68 6.624 3.666 5.862 PORT BENCH MARK IMU STARBOARD PONTOON 
69 6.624 8.571 5.798 STARBOARD BENCH MARK IMU STARBOARD PONTOON 
70 5.861 -6.865 5.767 IMU PORT PONTOON 
71 5.885 5.381 5.768 IMU STARBOARD PONTOON 
72 -20.247 -0.609 -4.327 BOTTOM OF CENTER BLOCK "A" FRAME 
73 11.205 -1.904 -7.782 BOTTOM OF GPS ANTENNAE PORT LOWER 
74 10.488 -1.896 -9.774 BOTTOM OF GPS ANTENNAE PORT UPPER 
75 11.180 0.594 -7.776 BOTTOM OF GPS ANTENNAE STARBOARD LOWER 
76 10.455 0.589 -9.776 BOTTOM OF GPS ANTENNAE STARBOARD UPPER 
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NOAA Ship Hassler 
POS Antenna and Spatial Relationship Survey  
 
PURPOSE 
 
The intention of this survey was to accurately position the relocated POS Antennas 
and Side Scan Sonar tow point. 
 
PROJECT DETAILS 
 
This survey was conducted on March 29, 2011 on Spring River Island in 
Pascagoula, MS.  NGS was provided data from a previous survey that contained a 
complete point listing of all components as well as recoverable bench mark 
stations.  The NOAA Ferdinand Hassler was in water causing some instability of 
the instrument and target reflectors.  The tilt compensator had to be bypassed in 
order to take measurements.       
 
INSTRUMENTATION 
 
The TOPCON GPT 3000 Series Total Station was used to make all measurements. 

A SECO 25 mm Mini Prism System configured to have a zero mm offset was used 
as target sighting and distance measurements. 

SOFTWARE AND DATA COLLECTION 

TDS Survey Pro Ver. 4.7.1 

ForeSight DXM Ver. 3.2.2 was used for post processing.  

PERSONNEL 

Kevin Jordan NOAA/NOS/NGS/Field Operations Branch 757-441-5478 

Doug Adams NOAA/NOS/NGS/Field Operations Branch 757-441-5480 

 

 
 
 
 
 



NOAA Ship Hassler 
POS Antenna and Spatial Relationship Survey  
 

SURVEY PROCEDURES 
 
RECOVERED STATIONS 
 
MID BENCH MARK TOP WHEEL HOUSE 

 
 
PORT BENCH MARK TOP WHEEL HOUSE 

 
 
STARBOARD BENCH MARK TOP WHEEL HOUSE 



 
 
AFT MID BENCH MARK BACK DECK 

 
 
PORT BENCH MARK BACK DECK 



 
 
STARBOARD BENCH MARK BACK DECK 

 
 
 



PORT BENCH MARK BRIDGE WING 
-NO PHOTOS OF THIS STATION 
 
NEW FEATURES 
 
PORT POS ANTENNA MOUNT 

 
 
 



STARBOARD POS ANTENNA MOUNT 

 
 
 
 
 
 



SIDE SCAN SONAR TOW POINT 
-Horizontal Survey Point (HSP) 
-Vertical Survey Point (VSP) 

 
 
 

 



Setup #1 
Using the coordinates from the previous survey, the field crew setup the theodolite 
on the MID BENCH MARK TOP WHEEL HOUSE and initialized on PORT 
BENCH MARK BRIDGE WING to obtain a starting azimuth.  From this setup, we 
collected the four POS antenna mount locations:  

PORT FWD ANTENNA 
PORT AFT ANTENNA 
STARBOARD FWD ANTENNA 
STARBOARD AFT ANTENNA 

 
Positional checks were made to bench mark stations (see attached comparison 
report): 

PORT BENCH MARK TOP WHEEL HOUSE 
STARBOARD BENCH MARK TOP WHEEL HOUSE 
PORT BENCH MARK BRIDGE WING 
 

A temporary point (TP1) was established on the flying bridge near the stairs in 
order to collect the location of the SIDE SCAN SONAR TOW POINT. 
 
Setup #2 
The field crew setup on TP1 and initialized on the MID BENCH MARK TOP 
WHEEL HOUSE.  From this setup, we collected: 

SIDE SCAN SONAR TOW POINT 
 

Positional checks were made to bench mark stations (see attached comparison 
report): 

MID BENCH MARK TOP WHEEL HOUSE  
AFT MID BENCH MARK BACK DECK 
 

Setup #3 
The field crew setup on AFT MID BENCH MARK BACK DECK and initialized 
on TP1.  Positional checks were made to bench mark stations (see attached 
comparison report): 

PORT BENCH MARK BACK DECK 
STARBOARD BENCH MARK BACK DECK 

 
 
 
 
 
 
 



DISCUSSION 
All sensor/benchmark coordinates are contained in spreadsheets “NOAA SHIP 
HASSLER.xls”   
 
The following table includes stations that were observed from more than 
one setup and for each, an inverse was computed to identify possible 
setup errors.  Each station checked with favorable results. 
 

OBSERVED to PUBLISHED COMPARISON (Units in Meters) 
NAME ∆ Northing  ∆ Easting  ∆ Elevation  

PORT BENCH MARK 
BRIDGE WING -0.003 -0.008 0 
PORT BENCH MARK 
TOP WHEEL HOUSE 0.030 -0.015 -0.003 
STARBOARD BENCH 
MARK TOP WHEEL 
HOUSE -0.026 0.010 -0.006 
MID BENCH MARK 
TOP WHEEL HOUSE 0.015 0.002 -0.007 
AFT MID BENCH 
MARK BACK DECK -0.020 -0.030 0.011 
PORT BENCH MARK 
BACK DECK 0.027 -0.002 -0.005 
STARBOARD BENCH 
MARK BACK DECK -0.015 0.018 -0.011 

 



Measurement

Coord. Sys. Caris POSMV Caris POSMV Caris POSMV Caris POSMV (from NGS survey) (from NGS survey)
x ‐11.199 1.929 1.050 1.395 NA NA NA NA Scaler Distance 8.143 Scaler Distance 8.138
y 1.929 ‐11.199 1.395 1.050 NA NA NA NA
z ‐12.741 ‐12.741 ‐12.749 ‐12.749 NA NA NA NA

(from GAMS Cal) (from GAMS Cal)
Scaler Distance 8.120 Scaler Distance 8.104

POSMV offsets are derived from Impasato Centerline Survey (2010) and NGS POS Antenna Survey (April 2011), and measurements by FH personnel.

Calculations

x 0 x 0
y 0.000 y 0.000 Port IMU to Fwd Port Ant Stbd IMU to Fwd Port Ant
z 0.1675 z 0.1675 (from NGS survey) (from NGS survey)

(in POSMV) (in POSMV) x 1.395 x 1.929
y 1.05 y ‐11.199

x 1.929 x 1.395 z ‐12.749 z ‐12.741
y ‐11.199 y 1.050
z ‐12.862 z ‐12.870 Port IMU to Fwd Port Ant Stbd IMU to Fwd Port Ant

(from Impastato) (in POSMV) (from Impastato) (in POSMV) (from PosPac calibration) (from PosPac calibration)
DN152 DN194‐A DN152 DN194‐A

x 0.000 x 0.000 x 1.395 1.424 x 2.010 2.002
y 0.000 y 0.000 y 1.008 1.008 y ‐11.189 ‐11.206
z ‐0.046 z ‐0.046 z ‐12.895 ‐12.895 z ‐12.906 ‐12.892

(from antenna) (in POSMV) (from antenna) (in POSMV) use this use this

x 1.929 x 1.395
y ‐11.199 y 1.050
z ‐12.741 z ‐12.749

(in POSMV) (in POSMV)

Top of Port IMU 
to aft port ant 
phase center

Top of Stbd 
IMU to fwd port 

ant phase 
center

Stbd IMU to Fwd Port Ant

Stbd IMU to Fwd Port Ant

Center of IMU 
Plate  to top of 

IMU

Antenna base 
to phase 
center

Top of Stbd IMU to Fwd Port Ant

(from POSMV V4 User 
Guide)

Center of Stbd 
IMU Plate to 

Fwd Port 
Antenna Base

Aft Port Ant to Aft Stbd Ant

Fwd Port Ant to Fwd Stbd Ant

Top of Port IMU to Aft Port Ant

Antenna base 
to phase 
center

Fwd Port Ant to Fwd Stbd Ant

Fwd Port Ant to Fwd Stbd Ant

Stbd IMU to HeavePort IMU to Aft Port Ant

Center of Port 
IMU Plate to 

Aft Port 
Antenna Base

Port IMU to Aft Port Ant

Center of IMU 
Plate  to top of 

IMU

(from POSMV V4 User 
Guide)

Stbd IMU to Heave

PosPac Offsets



Measurement

Coord. Sys. Caris Caris Hypack

x 1.203 12.402 Stbd 1.203

y 11.678 9.749 Fwd 11.678

z 1.180 13.920 Vertical 3.460

*Top of IMU is RP (Reference Pt)

Vessel Offsets for S250 7111 are derived from Impasato Centerline Survey (2010) and NGS POS Antenna Survey (April 2011), and measurements by FH personnel.

Calculations

x 0 x 0 x 1.203

y 0.000 y 0.000 y 11.678

z 0.1675 z 0.046 z 1.180

(in CARIS) (from Trimble diagram) (in CARIS) (from calculcations) (in CARIS)

x 1.203 x 11.199 x 0

y 11.770 y -1.929 y 0.000

z 1.122 z 12.862 z 2.280

(from Impastato) (in CARIS) (from Impastato) (in CARIS) (in Hypack)

x 0.000 x 1.203

y -0.092 y 11.770

z -0.110 z 1.122

(in CARIS) (from Impastato) (in CARIS)

(from Reson diagram)

x 0.000

y -0.092

z -0.110

(in CARIS)

x 1.203 x 12.402 x

y 11.678 y 9.749 y

z 1.180 z 13.920 z 3.460

(in CARIS) (in CARIS) (in Hypack)

Stbd IMU to 7111 Fwd Port Ant to 7111 RP Waterline to 7111 RP

(Hypack vertical is positive down 
from waterline.)

Fwd Port Ant to 
IMU Plate

IMU Plate to 
7111 Center of 

Plate

7111 Center of 
Plate to 7111 
Acoustic RP

Top Stbd IMU to 
Waterline

(from waterline 
spreadsheet)

Top of Stbd IMU to 7111 RP Fwd Port Ant RP to 7111 RP

IMU Plate to 
7111 Center of 

Plate

7111 Center of 
Plate to 7111 
Acoustic RP

Waterline to 7111 RP

(from POSMV V4 User 
Guide)

Stbd IMU to 
7111 RP

IMU to 7111 (MRU to Trans) Fwd Port Ant to 7111 (Nav to Trans) Hysweep Offsets

Antenna Phase 
Center to Port 

Ant

Top Stbd IMU to 
7111 RP

Top of IMU to 
Center of IMU 

Plate



Measurement
Coord. Sys. Caris Caris Reson Hypack

x 1.424 12.623 0.000 Stbd 1.424
y 0.380 -1.549 0.000 Fwd 0.380
z 1.493 14.233 0.031 Vertical 3.773

TILTED 4.5 degrees up to stbd TILTED 4.5 degrees up to stbd
*Top of IMU is RP (Reference Pt)

Vessel Offsets for S250 Stbd 7125 are derived from Impasato Centerline Survey (2010) and NGS POS Antenna Survey (April 2011), and measurements by FH personnel
Calculations

x 0 x 0 x 1.424

y 0.000 y 0.000 y 0.380
z 0.1675 z 0.046 z 1.493

(in POSMV) (from Trimble diagram) (in CARIS) (from calculcations) (in CARIS)

x 1.424 x 11.199 x 0

y 0.380 y -1.929 y 0.000

z 1.325 z 12.862 z 2.280
(from Impastato) (in CARIS) (from Impastato) (in CARIS) (in Hypack)

x 1.424

y 0.380

z 1.325
(from Impastato) (in CARIS)

x 1.424 x 12.623 x
y 0.380 y -1.549 y
z 1.493 z 14.233 z 3.773

(in CARIS) (in CARIS) (in Hypack)

Waterline to Stbd 7125 RP

Hysweep Offsets

Stbd IMU Plate 
to Stbd 7125 

Stbd IMU to Stbd 7125 RP Fwd Port Ant to Stbd 7125 RP

Stbd IMU to Stbd 7125 Fwd Port Ant to Stbd 7125

IMU Plate to 
Stbd 7125 

Antenna Phase 
Center to Port 

Ant

Reson Projector to Receiver 

Center of 
IMU Plate  to 

top of IMU

(from POSMV V4 
User Guide)

(from Reson diagram, entered in 
Reson Hardware configuration)

Stbd IMU to 
Stbd 7125

Stbd IMU to Stbd 7125 (MRU to 
Trans)

Fwd Port Ant to Stbd 7125 (Nav to 
Trans)

Fwd Port Ant to 
IMU Plate

Top Stbd 
IMU to 

Waterline

(from waterline 
spreadsheet)

(Hypack vertical is positive down from 
waterline.)

Waterline to Stbd 7125 RP
Top Stbd 

IMU to Stbd 
7125 RP



Measurement
Coord. Sys. Caris Caris Reson Hypack

x -1.244 -2.294 0.000 Stbd -1.244
y 0.362 -1.033 0.000 Fwd 0.362
z 1.486 14.234 0.031 Vertical 3.756

TILTED 4.5 degrees up to port TILTED 4.5 degrees up to port
*Top of IMU is RP (Reference Pt)

Vessel Offsets for S250 Stbd 7125 are derived from Impasato Centerline Survey (2010) and NGS POS Antenna Survey (April 2011), and measurements by FH personnel
Calculations

x 0 x 0 x -1.244

y 0.000 y 0.000 y 0.362

z 0.1675 z 0.046 z 1.486

(in CARIS) (from Trimble diagram) (in CARIS) (from calculcations) (in CARIS)

x -1.244 x -1.05 x 0

y 0.362 y -1.395 y 0.000
z 1.318 z 12.870 z 2.270

(from Impastato) (in CARIS) (from Impastato) (in CARIS) (in Hypack)

x -1.244

y 0.362
z 1.318

(from Impastato) (in CARIS)

x -1.244 x -2.294 x
y 0.362 y -1.033 y
z 1.486 z 14.234 z 3.756

(in Hypack)

Waterline to Stbd 7125 RP

Port IMU to 
Port 7125

Waterline to Stbd 7125 RP
Top Port IMU 
to Port 7125 

RP

Top Port IMU 
to Waterline

(from waterline 
spreadsheet)

(Hypack vertical is positive down 
from waterline.)

IMU to 
Port 7125 

Port IMU to Port 7125 Aft Port Ant to Port 7125

Port IMU 
Plate to Port 

7125 

Aft Port Ant to 
Port IMU Plate

Port IMU Plate 
to Port 7125 

(from POSMV V4 
User Guide)

Projector to Receiver Hysweep Offsets

Port IMU to Port 7125 Aft Port Ant to Port 7125

Port IMU to Port 7125 (MRU to 
Trans)

Aft Port Ant to Port 7125 (Nav to 
Trans)

Center of 
IMU Plate  to 
top of IMU

Antenna Phase 
Center to Port 

Ant



Measurement
Coord. Sys. Caris Caris Caris Caris Hypack Hypack

x -13.490 1.424 -2.291 12.623 Stbd -13.490 Stbd 1.424
y 0.338 0.380 -1.591 -1.549 Fwd 0.338 Fwd 0.380
z 1.485 1.493 14.225 14.233 Vertical 3.765 Vertical 3.773

*Top of Stbd IMU is RP (Reference Pt) TILTED 4.5 degrees up to port TILTED 4.5 degrees up to stbd
Tilted up 4.5 degrees up on both sides

Vessel Offsets for dual 7125 are derived from Impasato Centerline Survey (2010) and NGS POS Antenna Survey (April 2011), and measurements by FH personnel.
Calculations

x 0 x 0 x 0 x 0 x -13.490 x 1.424

y 0 y 0.000 y 0.000 y 0.000 y 0.338 y 0.380
z 0.1675 z 0.1675 z 0.046 z 0.046 z 1.485 z 1.493

(in CARIS) (in CARIS) (from Trimble diagram) (in CARIS) (from Trimble diagram) (in CARIS) (from calculcations) (in CARIS) (from calculcations) (in CARIS)

x -13.490 x 1.424 x 11.199 x 11.199 x 0 x 0

y 0.338 y 0.38 y -1.929 y -1.929 y 0.000 y 0.000

z 1.317 z 1.325 z 12.862 z 12.862 z 2.280 z 2.280
(from Impastato) (in CARIS) (from Impastato) (in CARIS) (from Impastato) (in CARIS) (from Impastato) (in CARIS) (in Hypack) (in Hypack)

x -13.49 x 1.424

y 0.338 y 0.380

z 1.317 z 1.325
(from Impastato) (in CARIS) (from Impastato) (in CARIS)

x -13.490 x 1.424 x -2.291 x 12.623 x x
y 0.338 y 0.380 y -1.591 y -1.549 y y
z 1.485 z 1.493 z 14.225 z 14.233 z 3.765 z 3.773

(in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

Note: For dual acquisition 7125, the HSX file contains data from both 7125s but only POSMV data from the stbd POSMV.  The port 7125 is swath 1 (beams 1-512) and the 
stbd 7125 is swath 2 (beams 513 to 1024).  

Stbd IMU Plate 
to Stbd 7125 

Fwd Port Ant to Stbd 7125 RP

Fwd Port Ant 
to Stbd IMU 

Plate

Center of Stbd 
IMU Plate  to 

top of IMU

Antenna Phase 
Center to Port 

Ant

(from POSMV V4 User 
Guide)

Stbd IMU Plate 
to Port 7125 

Stbd IMU to Port 7125 RP Fwd Port Ant to Port 7125 RPStbd IMU to Stbd 7125 RP

Antenna Phase 
Center to Port 

Ant

Stbd 7125 Hysweep Offsets

Stbd IMU to 
Stbd 7125

Waterline to Stbd 7125 RP
Top Stbd 

IMU to Stbd 
7125 RP

Top Stbd 
IMU to 

Waterline

(from waterline 
spreadsheet)

Waterline to Stbd 7125 RP

Top Stbd 
IMU to Port 

7125 RP

Top Stbd 
IMU to 

Waterline

(from waterline 
spreadsheet)

Waterline to Stbd 7125 RP

Stbd IMU to Port 7125 (MRU to Trans) -
Swath 1

Fwd Port Ant to Port 7125 (Nav to 
Trans) Port 7125 Hysweep Offsets

Stbd IMU to Port 7125 Fwd Port Ant to Port 7125 Waterline to Stbd 7125 RP

(Hypack vertical is positive down 
from waterline.)

Stbd IMU to 
Port 7125

Fwd Port Ant to Stbd 7125 (Nav to 
Trans)

Fwd Port Ant to Stbd 7125

Stbd IMU Plate 
to Port 7125 

Fwd Port Ant 
to Stbd IMU 

Plate

Stbd  IMU to Stbd 7125 (MRU to 
Trans) - Swath 2

Stbd IMU to Stbd 7125
Center of IMU 
Plate  to top of 

IMU

(from POSMV V4 User 
Guide)

IMU Plate to 
Stbd 7125 



Measurement

Coord. Sys. Caris

x ‐26.032
y 7.161
z ‐9.347

(in CARIS)

Port IMU to TowPoint



Measurement

Coord. Sys. Caris Caris

x ‐0.455
y 4.62
z 1.325

Stbd IMU to Stbd SB Stbd IMU to Port SB



Canards Zero Canards Up 15 deg Canards Down 25 deg

Speed 
(m/s)

Port Canard 
Zero ‐ 3rd 
Order

Stbd Canard 
Zero ‐ 3rd 
Order

Port 4th 
Order

Stbd 4th 
Order

Port Canard 
Up ‐ 3rd 
Order

Stbd Canard 
Up ‐ 3rd 
Order

Port 4th 
Order

Stbd 4th 
Order

Port Canard 
Down ‐ 3rd 

Order

Stbd Canard 
Down ‐ 3rd 

Order

Port 4th 
Order

Stbd 4th 
Order

0 0 0 0 0 0 0 0 0 0 0 0 0
0.5 ‐0.08 ‐0.06 0.04 0.06 0.04 0.03 0.18 0.15 ‐0.04 ‐0.06 ‐0.21 ‐0.21
1 ‐0.13 ‐0.1 0.04 0.08 0.06 0.05 0.27 0.23 ‐0.08 ‐0.11 ‐0.33 ‐0.34

1.5 ‐0.17 ‐0.13 0.01 0.07 0.09 0.07 0.3 0.25 ‐0.11 ‐0.15 ‐0.39 ‐0.41
2 ‐0.19 ‐0.15 ‐0.01 0.04 0.1 0.08 0.3 0.24 ‐0.13 ‐0.18 ‐0.41 ‐0.44

2.5 ‐0.2 ‐0.16 ‐0.04 0.02 0.12 0.1 0.29 0.23 ‐0.16 ‐0.21 ‐0.42 ‐0.46
3 ‐0.2 ‐0.15 ‐0.06 0 0.13 0.11 0.28 0.23 ‐0.18 ‐0.23 ‐0.43 ‐0.47

3.5 ‐0.19 ‐0.15 ‐0.06 0 0.15 0.12 0.28 0.23 ‐0.2 ‐0.26 ‐0.45 ‐0.5
4 ‐0.17 ‐0.13 ‐0.04 0.01 0.16 0.13 0.3 0.25 ‐0.23 ‐0.29 ‐0.49 ‐0.54

4.5 ‐0.15 ‐0.12 ‐0.02 0.03 0.18 0.15 0.34 0.28 ‐0.27 ‐0.33 ‐0.54 ‐0.59
5 ‐0.13 ‐0.1 0.02 0.07 0.2 0.17 0.39 0.33 ‐0.31 ‐0.38 ‐0.6 ‐0.65

5.5 ‐0.11 ‐0.08 0.05 0.1 0.23 0.2 0.45 0.38 ‐0.37 ‐0.44 ‐0.66 ‐0.72
6 ‐0.09 ‐0.06 0.08 0.12 0.26 0.23 0.49 0.43 ‐0.43 ‐0.51 ‐0.7 ‐0.77

6.5 ‐0.08 ‐0.04 0.07 0.12 0.3 0.28 0.51 0.46 ‐0.52 ‐0.6 ‐0.71 ‐0.78
7 ‐0.07 ‐0.03 0.02 0.08 0.36 0.34 0.48 0.44

7.5 ‐0.08 ‐0.03 ‐0.09 ‐0.04 0.42 0.41 0.36 0.36

0.4

0.6
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Vessel Speed (m/s)

Port Canard Up
Stbd Canard Up
Port Canard  Zero
Stbd Canard Zero
Port Canard Down
Stbd Canard Down



Date: NA Personnel: NA
DESIGN DRAFT OF 3.85 METERS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.85
Fwd 

Inboard
3.85

Fwd 
Inboard

3.85
Fwd 

Outboard
3.85

Aft 
Outboard

3.85 Aft Inboard 3.85
Aft 

Inboard
3.85

Aft 
Outboard

3.85

Port Ave 3.85 Stbd Ave 3.85

x x

y y

z -0.1675 z -0.1675

x x x x

y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.750 Calculated from draft mark 4.6 to draft readings Ave 0.750

x x x x

y y y y
z -2.280 z -2.283 z -2.288 z -2.286

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z -2.295 z -2.288 z -2.263 z -2.263

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.621 Ave -2.442

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.2795

Fwd 
Inboard

2.2825 -1
Fwd 

Inboard
2.2875

Fwd 
Outboard

2.2855 -1

Aft 
Outboard

2.2945
Fwd 

Inboard
2.2875

Fwd 
Inboard

2.2625
Aft 

Outboard
2.2625

Port Ave 2.286 Stbd Ave 2.2745

x x
Waterline y Waterline y
to IMU  (m) z 2.286 to IMU  (m) z 2.275

(In CARIS) (In CARIS)

Center of 
IMU Plate  to 

top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 4.6 

Draft Mark

IMU plate to 
Aft Outboard 

4.6 Draft Mark

Center of 
IMU Plate  to 

top of IMU

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline



Date: 5/3/2011 Personnel: Welton (inboard marks assumed to be same as outboard marks)
Location: Sing River Island Pier, Pascagoula, MS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.97
Fwd 

Inboard
3.97

Fwd 
Inboard

3.9
Fwd 

Outboard
3.9

Aft 
Outboard

3.85 Aft Inboard 3.85
Aft 

Inboard
3.85

Aft 
Outboard

3.85

Port Ave 3.91 Stbd Ave 3.875

x x
y y

z -0.1675 z -0.1675

x x x x
y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.630 z 0.630 z 0.700 z 0.700

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.690 Calculated from draft mark 4.6 to draft readings Ave 0.725

x x x x
y y y y
z -2.400 z -2.403 z -2.338 z -2.336

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -2.295 z -2.288 z -2.263 z -2.263

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.681 Ave -2.467

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.3995

Fwd 
Inboard

2.4025 -1
Fwd 

Inboard
2.3375

Fwd 
Outboard

2.3355 -1

Aft 
Outboard

2.2945
Fwd 

Inboard
2.2875

Fwd 
Inboard

2.2625
Aft 

Outboard
2.2625

Port Ave 2.346 Stbd Ave 2.2995

x x
Waterline y Waterline y
to IMU  (m) z 2.346 to IMU  (m) z 2.300

(In CARIS) (In CARIS)

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 

4.6 Draft Mark

IMU plate to 
Aft Outboard 
4.6 Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Center of 
IMU Plate  to 
top of IMU

Center of 
IMU Plate  to 
top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark



Date: 5/5/2011 Personnel: Cousins, Welton (draft marks read by Kayak)
Location: Sing River Island Pier, Pascagoula, MS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.825
Fwd 

Inboard
3.8

Fwd 
Inboard

3.75
Fwd 

Outboard
3.75

Aft 
Outboard

3.85 Aft Inboard 3.9
Aft 

Inboard
3.82

Aft 
Outboard

3.82

Port Ave 3.84375 Stbd Ave 3.785

x x

y y

z -0.1675 z -0.1675

x x x x

y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.775 z 0.800 z 0.850 z 0.850

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z 0.750 z 0.700 z 0.780 z 0.780

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.756 Calculated from draft mark 4.6 to draft readings Ave 0.815

x x x x

y y y y
z -2.255 z -2.233 z -2.188 z -2.186

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z -2.295 z -2.338 z -2.233 z -2.233

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.615 Ave -2.377

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.2545

Fwd 
Inboard

2.2325 -1
Fwd 

Inboard
2.1875

Fwd 
Outboard

2.1855 -1

Aft 
Outboard

2.2945
Fwd 

Inboard
2.3375

Fwd 
Inboard

2.2325
Aft 

Outboard
2.2325

Port Ave 2.27975 Stbd Ave 2.2095

x x
Waterline y Waterline y
to IMU  (m) z 2.280 to IMU  (m) z 2.210

(In CARIS) (In CARIS)

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 4.6 

Draft Mark

IMU plate to 
Aft Outboard 

4.6 Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Center of 
IMU Plate  to 

top of IMU

Center of 
IMU Plate  to 

top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark



Date: 5/12/2011 Personnel: Cousins (inboard marks assumed to be same as outboard marks)
Location: Sing River Island Pier, Pascagoula, MS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.78
Fwd 

Inboard
3.78

Fwd 
Inboard

3.8
Fwd 

Outboard
3.8

Aft 
Outboard

3.8 Aft Inboard 3.8
Aft 

Inboard
3.9

Aft 
Outboard

3.9

Port Ave 3.79 Stbd Ave 3.85

x x
y y

z -0.1675 z -0.1675

x x x x
y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.820 z 0.820 z 0.800 z 0.800

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z 0.800 z 0.800 z 0.700 z 0.700

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.810 Calculated from draft mark 4.6 to draft readings Ave 0.750

x x x x
y y y y
z -2.210 z -2.213 z -2.238 z -2.236

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -2.245 z -2.238 z -2.313 z -2.313

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.561 Ave -2.442

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.2095

Fwd 
Inboard

2.2125 -1
Fwd 

Inboard
2.2375

Fwd 
Outboard

2.2355 -1

Aft 
Outboard

2.2445
Fwd 

Inboard
2.2375

Fwd 
Inboard

2.3125
Aft 

Outboard
2.3125

Port Ave 2.226 Stbd Ave 2.2745

x x
Waterline y Waterline y
to IMU  (m) z 2.226 to IMU  (m) z 2.275

(In CARIS) (In CARIS)

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 

4.6 Draft Mark

IMU plate to 
Aft Outboard 
4.6 Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Center of 
IMU Plate  to 
top of IMU

Center of 
IMU Plate  to 
top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark



Date: 5/17/2011 Personnel: VanWaes (inboard marks assumed to be same as outboard marks)
Location: Sing River Island Pier, Pascagoula, MS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.78
Fwd 

Inboard
3.78

Fwd 
Inboard

3.9
Fwd 

Outboard
3.9

Aft 
Outboard

3.85 Aft Inboard 3.85
Aft 

Inboard
3.95

Aft 
Outboard

3.95

Port Ave 3.815 Stbd Ave 3.925

x x
y y

z -0.1675 z -0.1675

x x x x
y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.820 z 0.820 z 0.700 z 0.700

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z 0.750 z 0.750 z 0.650 z 0.650

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.785 Calculated from draft mark 4.6 to draft readings Ave 0.675

x x x x
y y y y
z -2.210 z -2.213 z -2.338 z -2.336

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -2.295 z -2.288 z -2.363 z -2.363

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.586 Ave -2.517

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.2095

Fwd 
Inboard

2.2125 -1
Fwd 

Inboard
2.3375

Fwd 
Outboard

2.3355 -1

Aft 
Outboard

2.2945
Fwd 

Inboard
2.2875

Fwd 
Inboard

2.3625
Aft 

Outboard
2.3625

Port Ave 2.251 Stbd Ave 2.3495

x x
Waterline y Waterline y
to IMU  (m) z 2.251 to IMU  (m) z 2.350

(In CARIS) (In CARIS)

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 

4.6 Draft Mark

IMU plate to 
Aft Outboard 
4.6 Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Center of 
IMU Plate  to 
top of IMU

Center of 
IMU Plate  to 
top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark



Date: NA Personnel: NA
DESIGN DRAFT OF 3.85 METERS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.8
Fwd 

Inboard
3.8

Fwd 
Inboard

3.75
Fwd 

Outboard
3.75

Aft 
Outboard

3.85 Aft Inboard 3.85
Aft 

Inboard
3.85

Aft 
Outboard

3.85

Port Ave 3.825 Stbd Ave 3.8

x x

y y

z -0.1675 z -0.1675

x x x x

y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.800 z 0.800 z 0.850 z 0.850

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.775 Calculated from draft mark 4.6 to draft readings Ave 0.800

x x x x

y y y y
z -2.230 z -2.233 z -2.188 z -2.186

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z -2.295 z -2.288 z -2.263 z -2.263

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.596 Ave -2.392

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.2295

Fwd 
Inboard

2.2325 -1
Fwd 

Inboard
2.1875

Fwd 
Outboard

2.1855 -1

Aft 
Outboard

2.2945
Fwd 

Inboard
2.2875

Fwd 
Inboard

2.2625
Aft 

Outboard
2.2625

Port Ave 2.261 Stbd Ave 2.2245

x x
Waterline y Waterline y
to IMU  (m) z 2.261 to IMU  (m) z 2.225

(In CARIS) (In CARIS)

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 4.6 

Draft Mark

IMU plate to 
Aft Outboard 

4.6 Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Center of 
IMU Plate  to 

top of IMU

Center of 
IMU Plate  to 

top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark



Date: NA Personnel: NA
DESIGN DRAFT OF 3.85 METERS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.9
Fwd 

Inboard
3.85

Fwd 
Inboard

3.9
Fwd 

Outboard
3.9

Aft 
Outboard

3.75 Aft Inboard 3.75
Aft 

Inboard
3.85

Aft 
Outboard

3.85

Port Ave 3.8125 Stbd Ave 3.875

x x

y y

z -0.1675 z -0.1675

x x x x

y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.700 z 0.750 z 0.700 z 0.700

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z 0.850 z 0.850 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.788 Calculated from draft mark 4.6 to draft readings Ave 0.725

x x x x

y y y y
z -2.330 z -2.283 z -2.338 z -2.336

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z -2.195 z -2.188 z -2.263 z -2.263

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.584 Ave -2.467

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.3295

Fwd 
Inboard

2.2825 -1
Fwd 

Inboard
2.3375

Fwd 
Outboard

2.3355 -1

Aft 
Outboard

2.1945
Fwd 

Inboard
2.1875

Fwd 
Inboard

2.2625
Aft 

Outboard
2.2625

Port Ave 2.2485 Stbd Ave 2.2995

x x
Waterline y Waterline y
to IMU  (m) z 2.249 to IMU  (m) z 2.300

(In CARIS) (In CARIS)

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 4.6 

Draft Mark

IMU plate to 
Aft Outboard 

4.6 Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Center of 
IMU Plate  to 

top of IMU

Center of 
IMU Plate  to 

top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark



Date: NA Personnel: NA
DESIGN DRAFT OF 3.85 METERS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.95
Fwd 

Inboard
3.85

Fwd 
Inboard

3.85
Fwd 

Outboard
3.85

Aft 
Outboard

3.85 Aft Inboard 3.85
Aft 

Inboard
3.85

Aft 
Outboard

3.85

Port Ave 3.875 Stbd Ave 3.85

x x

y y

z -0.1675 z -0.1675

x x x x

y y y y
z -3.197 z -3.200 z -3.205 z -3.203

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.212 z -3.205 z -3.180 z -3.180

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From Impastato Survey Ave -3.204 From Impastato Survey Ave -3.192

x x 4.6 x x

y y y y
z 0.650 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.725 Calculated from draft mark 4.6 to draft readings Ave 0.750

x x x x

y y y y
z -2.380 z -2.283 z -2.288 z -2.286

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z -2.295 z -2.288 z -2.263 z -2.263

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.646 Ave -2.442

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.3795

Fwd 
Inboard

2.2825 -1
Fwd 

Inboard
2.2875

Fwd 
Outboard

2.2855 -1

Aft 
Outboard

2.2945
Fwd 

Inboard
2.2875

Fwd 
Inboard

2.2625
Aft 

Outboard
2.2625

Port Ave 2.311 Stbd Ave 2.2745

x x
Waterline y Waterline y
to IMU  (m) z 2.311 to IMU  (m) z 2.275

(In CARIS) (In CARIS)

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU Plate to 
Aft Outboard 
4.6 M Draft 

Mark

IMU Plate to Aft 
Inboard 4.6 
Draft Mark

IMU plate to 
Aft Inboard 4.6 

Draft Mark

IMU plate to 
Aft Outboard 

4.6 Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Center of 
IMU Plate  to 

top of IMU

Center of 
IMU Plate  to 

top of IMU

IMU Plate to 
Fwd Outboard 
4.6 Draft Mark

IMU Plate to 
Fwd Inboard 4.6 

Draft Mark

IMU plate to 
Fwd Inboard 

4.6 Draft Mark

IMU plate to 
Fwd Outboard 
4.6 Draft Mark



PORT STBD Notes
Average 2.27475 2.286643 Waterline
SD 0.0413 0.042215 Loading Uncertainty



Appendix II 
 
 
Echosounder Reports 
 



Hassler
Multibeam Echosounder Calibration

7/7/2011
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

7/7/2011
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

188 Norfolk Canyon Wreck PA provided by OE

unknown 80 meters

Stbd fwd pontoon

Stbd side POSMV none

188 Norfolk Canyon Wreck PA provided by OE

Welton, Van Waes, Wilson

Reson 7111 Stbd UK

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
MVP 165 8.9

347 4.5

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) RemarksLine Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

Line Filename
2011_1881244
2011_1881253

2011_188_S250_Port_NorfolkCanyonA.000

MVP Files All Day



MVP 165 7.5
345 7.5

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
MVP 163 8.0

344 8.0
164 8.0

ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
MVP

Line Filename

Line Filename
2011S_1881303
2011S_1881311
2011S_1881319

2011_1881224 On west side of target
2011_1881236

Processing Log

6/7/2011
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged Computed TPU

Data cleaned to remove gross fliers Applied SBETs and Error Files

PATCH TEST RESULTS/CORRECTORS

Concatenated, processed MVP file

zero tide

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

188 MJW

Data converted --> HDCS_Data in CARIS

2011_188_S250_Port_NorfolkCanyon_A.000



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.20 -0.05 0.40
0.00 -0.21 -0.05 0.12

0.00 0.00 -0.05 0.26
0.00 0.29 0.00 0.20
0.00 0.00 -0.05 0.26

Resulting HVF File Name

MRU Align StdDev gyro 0.26 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.14 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

Final Values based on

Both HSX and S7K processed with SBETs and Error Files from POSPAC.

Averages
Standard Deviation

FINAL VALUES

PS Wilson
LT Greenaway

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:



FERDINAND R. HASSLER
Multibeam Echosounder Calibration

Vessel

7/7/2011
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Please choose a vessel

188 Norfolk Canyon Wreck PA

Welton, PS Wilson, Higgs (Reson)

Reson 7125 Port Pontoon



Acquisition Log

7/7/2011
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
MVP 345 4.6

165 9.6

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

Line Filename
2011_1881537
2011_1881547

Concatenated MVP files

188 Norfolk Canyon Wreck PA 2-4 ft swells, 1-2 ft seas, 10 kt winds

10 meters

FOO, Parker, Wilson, Higgs

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
MVP 165 7.4

345 7.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
MVP 345 8.4

165

345 8.02011_1881611

Line Filename
2011_1881556
2011_1881604

Line Filename
2011_1881504
2011_1881515



165 8.02011_1881618



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) RemarksLine Filename

Use Pitch



Processing Log

7/7/2011
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged Computed TPU

Data cleaned to remove gross fliers Applied SBETs and Error Files

S250_ResonSAT_NorfolkCanyonWrk.svp

zerotide

n/a

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

189 PS Wilson

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
-0.10 0.40 0.10 -1.20
0.00 0.15 0.07 -0.40
0.03 -0.09 0.05 -1.41

0.00 0.40 -0.08 -0.35
0.00 0.14 -0.08 -0.82

0.00 0.27 -0.08 -0.59
0.00 0.18 0.00 0.33
0.00 0.27 -0.08 -0.59

Resulting HVF File Name

MRU Align StdDev gyro 0.15 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.09 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

Not sure the casue. 

Final Values based on Averageof second trails- first discarded.

PS Wilson values (2nd attempt):  latency and pitch were both no change.  Roll value -0.08, yaw value -0.35
LT Greenaway, 2nd attemp - roll -0.08

LT Greenaway(2)

Averages
Standard Deviation

FINAL VALUES

PATCH TEST RESULTS/CORRECTORS

PS Wilson
Welton (remove)
LT Greenaway

PS Wilson (2)

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:



FERDINAND R. HASSLER
Multibeam Echosounder Calibration

Vessel

7/7/2011
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Please choose a vessel

188 Norfolk Canyon

Reson 7125 Stbd Pontoon



Acquisition Log

7/7/2011
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
MVP 345 5.2

163 8.0

188 Norfolk Canyon West, 8 kts, 1-2 ft seas, 2-4 ft swell

80 meters

Welton, Van Waes, Wilson, Higgs

2011_188_S250_Stbd_NorfolkCanyon_A

MVP

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

Line Filename
2011S_1881355
2011S_1881406

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks
MVP 345 7.3

163 7.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

Line Filename
2011S_1881335
2011S_1881346

Line Filename



MVP 345 7.0
165 7.0
345 7.0
165 7.0
345 7.0

2011S_1881417
2011S_1881424
2011S_1881432
2011S_1881442
2011S_1881450



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks Line Filename

use pitch lines



Processing Log

7/7/2011
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged Computed TPU

Data cleaned to remove gross fliers Applied SBETs and Error Files

188 PS Wilson

Data converted --> HDCS_Data in CARIS

2011_188_S250_Stbd_NorfolkCanyon_A.000

S250_ResonSAT_NorfolkCanyonWrk.svp

zerotide

n/a

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.13 -0.07 0.72
-0.14 0.40 -0.05 0.80
0.00 0.13 -0.05 0.60
0.00 -0.11 -0.05 0.56

-0.04 0.07 -0.06 0.67
0.07 0.25 0.01 0.11
0.00 0.07 -0.06 0.67

Resulting HVF File Name

MRU Align StdDev gyro 0.11 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.13 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

PATCH TEST RESULTS/CORRECTORS

Wilson
Van Waes
Welton
LT Greenaway

Averages
Standard Deviation

FINAL VALUES

Final Values based on

Both HSX and S7K processed and SBETs and Error Files applied from POSPAC.

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:



S250‐Dual Head Worksheet
IMU Difference ‐  From POS PAC
(stbd ‐ port in IMU coordinate system, right hand, posx fwd, pos y stbd, pos z down.)
arc‐minutes

file Heading uncert Pitch uncert Roll uncert notes
2011_194_StbdA ‐85 2 2 0.3 ‐10.3 0.5
2011_194_StdbB ‐86 2 1.8 0.4 ‐9 2 trend ‐ tidal? In roll difference
2011_193_S250_Stbd_Canards_Up ‐85 1 1.8 0.5 ‐8.6 1
188_Stbd_norfolkCanyon_B ‐85 3 1.8 0.5 ‐8.3 1.2

average ‐85.25 2 1.85 0.425 ‐9.05 1.175

PORT to STBD IMU (in POS ‐ DEG) ‐1.42 0.03 0.03 0.01 ‐0.15 0.02
PORT to STBD IMU (in CARIS ‐ DEG) ‐1.42 ‐0.03 0.15 pitch and roll have opposite sign in POS and CARIS

PORT 7125 Patch Test Values (in CARIS) ‐0.59 0.27 ‐0.08

PORT 7125 to STBD IMU ‐2.01 0.24 0.07



FH 2011 Sidescan Calibration
Side Scan run on Dn279, 2011.  MBES run on Dn277, 2011 
Contact is conspicuous point on debris field off Cape Charles City

MBES Position of Contact
Lat (DD) Long (DD)
37.2338 ‐76.0775

SSS Contacts Lat Diff (m) Long Diff (m) Distance (m) All x,y Diff
1 37.2337 ‐76.0774 ‐6.0 2.8 6.6
2 37.2337 ‐76.0775 ‐4.7 1.5 4.9
3 37.2338 ‐76.0775 ‐0.8 ‐3.2 3.3
4 37.2338 ‐76.0774 1.2 3.5 3.7
5 37.2338 ‐76.0775 ‐0.6 ‐2.2 2.2
6 37.2338 ‐76.0774 0.0 3.9 3.9
7 37.2337 ‐76.0774 ‐7.7 2.6 8.2
8 37.2338 ‐76.0774 ‐0.5 2.0 2.1
9 37.2338 ‐76.0774 ‐3.0 2.1 3.6

10 37.2338 ‐76.0775 ‐0.5 ‐0.8 0.9
11 37.2338 ‐76.0774 ‐0.8 3.8 3.9
12 37.2338 ‐76.0775 ‐1.7 ‐3.7 4.1

N 12 Average ‐2.1 1.0 3.9 ‐0.5
DOF: 2N‐1 23 StDev 2.7 2.8 3.1

Criteria: 95% Confidence that any future measurement will not give a positional error 
greater than 10 meters. 

A i d d b h l di ib i hAssuming x and y errors are goverened by the same normal distribution, the
square of the distance error is governed by Chi‐squared statistics. 

So:

Setting the distance error equal to 10 meters and using the Chi‐squared
value for one degree of freedom and alpha = 0.05, solve for the maximum value
for the standard deviation of the x or y error.

Distance Error Limit (meters) 10
Max. x,y Std Deviation 5.1

The sample estimate of the standard deviation will also be Chi‐squared distributed

At a 95% confidence interval the standard deviation range is:
low best est. high

x,y StDev 2.4 3.1 4.4 PASS
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During the period of May16th to May 18th, 2011 two POSMV systems were commissioned 
aboard NOAA vessel Ferdinand Hassler. The following is a summary of the events and final 
observations.  
 
Chronology: 
May 16th-  

Travel from Houston TX to New Orleans LA. Overnight in Gulfport MS with the 
intention of meeting the ship in the morning to conduct dockside testing in the 
morning before the ship sets sail in the afternoon. Informed by Steve Laverty 
there has been a change in plan and the CO wants to depart the dock at 0900 
tomorrow instead.  
 

May 17th-  
 Arrive ship 0730. Brief review of POSMV installation with Briana Welton followed 

by cursory inspection.  Both POSMV systems are up and running with no errors. 
Collected a set of dockside POSMV data from both systems for processing in 
POSPAC later today. Plan is to meet at the NOAA facility in Pascagoula at 0630 
and transit out to ship in small boat.  

 
May 18th-  0630- Depart Pascagoula for Ferdinand Hassler. Upon arrival commenced 

system inspection and diagnostics. No faults found. Conducted two GAMS 
calibrations on both POSMV systems and  completed system acceptance testing.  

 
   
Calibration and testing results: 

1. The GAMS calibration was completed on May 18th and checked against the calculations 
derived from the survey report. Further comparisons are required but it appears that the 
survey calculations differ somewhat from the GAMS measured values.  

Notes: 
  As a result of post processing the data set collected during commissioning, it was 
discovered that the POSMV IMU’s were actually reversed at the back of the POSMV PCS units. 
Because of the symmetry in the two systems, these errors were not immediately obvious during 
the trials; however the lever arm errors were apparent in the data set.  After physically changing 
the IMU inputs the processed calibration data was now reasonable when compared to the 
measured survey results. A new GAMS calibration was performed by the NOAA personnel after 
the IMU cables were returned to the correct orientation and the information below is based upon 
the correct orientation.  

Bruce A. Francis Applanix Corporation. 
17461 Village Green Drive 
Houston TX 77040 
USA 
Tel: (713) 896-9900 
Fax: (713) 896-9919 
bfrancis@applanix.com 
http://www.applanix.com 

 Company: Oak Management 

Attention 
of: 

Steve Laverty   

Email:   steve.laverty@oakmanagement.com 

From: Bruce A. Francis 

Date: 18 May, 2011  

Ref.: POSMV Installation aboard  

Ferdinand Hassler-SWATH 
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Recommendations:  
 
While the large separation between the GPS antennas across decks will improve heading 
accuracy, there is a possibility that flexure in the ship will cause poor GAMS performance as the 
baseline vectors may become unstable. We were unable to fully test this configuration in a calm 
sea but if this turns out to be the case after the ship experiences a modest increase in sea state, 
the solution might be to extend the separation between the antennas on the individual mounts 
and switch the antenna input to the POS from cross decks to using the pairs from each side to 
their corresponding POS unit. The minimum separation should be 1 meter whereas now the 
distance is only about 0.6m and slightly too short to expect normal GAMS performance.  
 
 
 
 

 
Submitted By: 
Bruce A. Francis 
Customer Support Engineer 
Marine Products 
713-896-9900 
bfrancis@applanix.com 
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Vessel Name Ferdinand R. Hassler 
Year Built 2010 
POSMV Location Port Side 
PCS Serial Number 3187 

IMU Serial Number 
Top Hat 

 
804 (Cable S/N 105) 

Hardware Version 3.3-7 

Firmware Version 5.03 

POS IP Address 
Subnet Mask 

129.100.2.231 
255.255.0.0 

POS PC Address 
Subnet Mask 

129.100.2.234 
255.255.255.0 

Survey Software Hypack 11.0.8.0 
Multibeam System Reson 7125 

 

 
Port System Lever Arms: (Units are in Meters) 
Point X Axis Y Axis Z Axis Notes 
Reference point 0.0 0.0 0.0 PORT IMU 
Ref to IMU 0.0 0.0 0.0 PORT IMU 
Ref to Primary GPS 1.395 1.05 -13.084 Port Aft antenna 
Ref to Secondary GPS 1.418 9.188 -13.080 Strb Aft antenna  
Ref to AUX GPS N/A N/A N/A Not surveyed 
Ref to Vessel 0.0 0.0 0.0 POS NMEA, message point 

of validity at target on IMU. 
IMU frame w.r.t Ref 
frame 

0.0 0.0 0.0 Rotation of IMU frame in 
comparison to ships frame.  

Ref to Heave (COR) 0.0 0.0 0.0 Center of gravity (rotation) 
Information not available.  

Ref to Sensor 1 0.0 0.0 0.0 Point of validity of HPR 
+Posn-Valid at IMU 

Ref to Sensor 2 0.0 0.0 0.0 Point of validity-HPR +Posn-
Valid at IMU 
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General System information: 
 
Options included- RTK (RTK-0); True Heave (THV-0); (DPW-0) Password protection 
Disabled 
 
Port POSMV 

 
 
 
 
Basic installation geometry: 
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POSRT Data Extraction Utility [Jun 15 2011] 
Copyright (c) 2008-2011 Applanix Corporation.  All rights reserved. 
Date : 07/25/11    Time : 15:12:36 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
First POS file      : E:\Clients config, IP, & test results\NOAA\NOAA 
Swath\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Port_A_GAMS.000 
Last POS file       : E:\Clients config, IP, & test results\NOAA\NOAA 
Swath\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Port_A_GAMS.000 
Output path         : C:\Documents and Settings\bfrancis\My Documents\POSPac 
MMS\Unnamed(1)\Swath Port IMU\Extract 
Output kernel       : Swath Port IMU 
Start time          : 0.000 
End time            : 999999.000 
VNAV output modulus : 1 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307750.275 : The First Group 99: Versions & Statistics 
   System Version: 
     Product-Model: MV-320; Version: VER4; Serial Number: S/N3187; 
     Hardware Version: HW3.3-7; 
     Software Release Version-Date: SW05.03-Mar10/10; 
     ICD release version: ICD04.02; 
     Operating System Version: OS425B14; 
     IMU Type: IMU2; Primary GPS Type: PGPS13; Secondary GPS Type: SGPS13; 
     Option mnemonic-Expiry Time: DMI0; 
     Option mnemonic-Expiry Time: GIM0; 
     Option mnemonic-Expiry Time: RTK-0; 
     Option mnemonic-Expiry Time: THV-0; 
     Option mnemonic-Expiry Time: DPW-0; 
   Primary GPS Version: BD950     SN:4814A14457, v.00232, channels:24; 
   Secondary GPS Version: BD950     SN:4814A14447, v.00232, channels:24; 
   Total Hours          :    561.4; Number of Runs:     53 
   Average Length of Run:   10.6; Longest Run:  126.2; Current Run:   12.1; 
-------------------------------------------------------------------------------- 
307750.275 : Diffcorr2 time1 gap: start 0.0, end 307750.2749 
307750.280 : IMU type: IMU2  Data rate = 200 Hz 
307750.280 : Extracting Group 4 : Time-tag data 
307750.290 : SNV status changed to 0  (Full Nav) 
307751.070 : Primary GNSS receiver type is GNSS13. 
307751.090 : Secondary GNSS receiver type is GNSS13. 
307755.275 : GenB( 9):  GAMS solution in use CLEARED. 
307756.275 : GenB( 9):  GAMS solution in use SET. 
307758.275 : GenB( 9):  GAMS solution in use CLEARED. 
-------------------------------------------------------------------------------- 
307759.275 : Message 50: Transition to NAVIGATE mode. 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 37: Base 1 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: NAD83  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 38: Base 2 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: WGS84  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 20: General parameters 
   Time and distance tag types:          2  1 
   Autostart selection:                   ENABLED 
   Reference-IMU lever arm:              -0.008  -0.031  0.130 
   Reference-primary GPS lever arm:      1.395  1.050  -13.084 
   Reference-auxiliary 1 GPS lever arm:  0.000  0.000  0.000 
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   Reference-auxiliary 2 GPS lever arm:  0.000  0.000  0.000 
   Reference-IMU mounting angles:        0.000  0.000  0.000 
   Reference-vehicle mounting angles:    0.000  0.000  0.000 
   Multipath environment:                 LOW 
-------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------- 
307759.275 : Message 22: Aiding sensor install parameters 
   DMI scale factor:                    0.00 
   Reference-DMI lever arm:             0.00    0.00    0.00 
   DVS scale factor correction:         1.00 
   Reference-DVS lever arm:             0.00    0.00    0.00 
   Reference-DVS attitude:              0.00    0.00    0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 24: User accuracy parameters 
   User position accuracy:       2.00 
   User velocity accuracy:       0.50 
   User attitude accuracy:       0.05 
   User heading accuracy:        0.05 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 106: Heave ratios 
   Heave Bandwidth (sec):  12.000 
   Heave Damping Ratio:  0.707 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 120: Heave and sensor 1&2 install parameters 
   Reference->Sensor1 alignment angles (R,P,Y) in degrees:  0.00  0.00  0.00 
   Reference->Sensor2 alignment angles (R,P,Y) in degrees:  0.00  0.00  0.00 
   Reference->Sensor1 lever arm in meters:                  0.00  0.00  0.00 
   Reference->Sensor2 lever arm in meters:                  0.00  0.00  0.00 
   Reference->Center of Rotation in meters:                    0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 121: Vessel Installation Parameters 
   Reference-Vessel in meters:                             0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 32: PCS IP address 
   IP Address (Network part 1): 129 
   IP Address (Network part 2): 100 
   IP Address (Host part 1):    1 
   IP Address (Host part 2):    232 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 56: General data 
   Initial status:     COARSE_LEVEL 
   Initial position:   30.339734242 -88.576108929 -24.927 
   Initial distance:   0.00 
   Initial attitude:   0.000 0.000 0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 21: GAMS install parameters 
   A-B antenna separation:        8.112 
   A-B baseline vector:           -0.060 8.112 0.021 
   Heading error for calibration: 0.50 
   A-B azimuth correction:        0.000 
-------------------------------------------------------------------------------- 
Available subsystems                  :  IMU 
                                      :  Primary GNSS 
                                      :  Secondary GNSS 
                                      :  Differential Corrections 
Vehicle to reference alignment angles :  0.000  0.000  0.000 
Multipath setting                     :  LOW 
Reference to IMU lever arm            : -0.008 -0.031  0.130 
Reference to IMU alignment angles     :  0.000  0.000  0.000 
Reference to primary GNSS lever arm   :  1.395  1.050 -13.084 
GAMS antenna separation               :  8.104 
GAMS baseline vector                  :  0.152  8.103 -0.004 
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GAMS heading calibration threshold    :  0.500 
GAMS heading correction               :  0.000 
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Observed GAMS values derived from the field calibration: 
 
Port GAMS Cal #1 
 

 



  NOAA  
  Ferdinand Hassler   

 Page 10 of 26 

 
 
 
 
Primary GPS data observed from internal Trimble BD950 receivers. 

 
 
 
 
 
Secondary embedded GPS data: 
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Com port #1 settings as installed: DGPS input from Trimble SPS Receiver. 

 
 
Com port #2 settings as installed 

 
 
Com port #3 settings as installed:  
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Com port #4 settings as installed:  
 

 
 
 
Com port #5 settings as installed 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Heave data plot: 
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The heave plot above shows the relationship between the Real-time (RT) heave and the True (or 
delayed TH) heave measurements. The green line relates to quality control (QC) and represents 
the difference between the two values. When the delta between the RT and TH exceeds 5cm or 
5% of total heave (pink line) then the radio light on the main controller screen will turn from green 
to red but does not affect the real-time heave data being collected. Quite often this occurs after 
the vessel makes a turn or an abrupt change in speed and is not necessarily cause for alarm.  
The heave filter has a 105 second buffer so the event which may have caused the impulse 
happened in the past.  A red light merely calls the users attention to the difference and may also 
suggest that the filter settings need to be refined if the QC value is continually out of bounds.   
 
Note: The TrueHeave data filter is delayed about 3 minutes from the TH value. Also, Group 111 & 
113 must be enabled in the Ethernet Real-time logging page.  In addition, this filter should be 
adjusted as required for changes in the local swell conditions.   
Heave Settings valid for both POSMV systems.  
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The main controller screens below shows normal POSMV operation. POS Mode is FULL 
indicating that all user accuracy settings have been satisfied.  Note, when using RTK the 
position threshold should be set to a smaller value i.e. 0.100m or whatever is specified in 
the survey parameters.  Exceeding any of the limits below will cause one of the radio 
lights to turn red and the POS mode will no longer report “Full Navigation” This however 
only affects the flag in the GGA or GGK message and not the performance.  
 
 

 
 
Port POSMV Final Navigation      
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Port side antenna and IMU mounting:  
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Vessel Name Ferdinand R. Hassler 
Year Built 2010 
POSMV Location STRB Side 
PCS Serial Number 3189 

IMU Serial Number 
Top Hat 

 
803 (Cable S/N 104) 

Hardware Version 3.3-7 

Firmware Version 5.03 

POS IP Address 
Subnet Mask 

129.100.1.231 
255.255.0.0 

POS PC Address 
Subnet Mask 

129.100.1.234 
255.255.255.0 

Survey Software Hypack 11.0.8.0 
Multibeam System Reson 7125 

 
Port System Lever Arms: (Units are in Meters) 
Point X Axis Y Axis Z Axis Notes 
Reference point 0.0 0.0 0.0 STRB IMU 
Ref to IMU 0.0 0.0 0.0 STRB IMU 
Ref to Primary GPS 1.929 -11.199 -13.084 Port FWD antenna 
Ref to Secondary GPS 1.953 -3.056 -13.083 Strb FWD antenna  
Ref to AUX GPS N/A N/A N/A Not surveyed 
Ref to Vessel 0.0 0.0 0.0 POS NMEA, message point 

of validity at target on IMU. 
IMU frame w.r.t Ref 
frame 

0.0 0.0 0.0 Rotation of IMU frame in 
comparison to ships frame.  

Ref to Heave (COR) 0.0 0.0 0.0 Center of gravity (rotation) 
Information not available.  

Ref to Sensor 1 0.0 0.0 0.0 Point of validity of HPR 
+Posn-Valid at IMU 

Ref to Sensor 2 0.0 0.0 0.0 Point of validity-HPR +Posn-
Valid at IMU 
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STRB POSMV 
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POSRT Data Extraction Utility [Jun 15 2011] 
Copyright (c) 2008-2011 Applanix Corporation.  All rights reserved. 
Date : 07/25/11    Time : 15:12:36 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
First POS file      : E:\Clients config, IP, & test results\Swath 250 Testing\Final 
Report Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.000 
Last POS file       : E:\Clients config, IP, & test results\Swath 250 Testing\Final 
Report Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.003 
Output path         : C:\Documents and Settings\bfrancis\My Documents\POSPac 
MMS\Unnamed(2)\Mission 1\Extract 
Output kernel       : Mission 1 
Start time          : 0.000 
End time            : 999999.000 
VNAV output modulus : 1 
-------------------------------------------------------------------------------- 
Opening file: E:\Clients config, IP, & test results\Swath 250 Testing\Final Report 
Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.000 
307625.639 : Output time 1 is in UTC time 
307625.639 : Output time 2 is in POS time 
307625.639 : Output distances are in POS distance 
307625.639 : IMU type: IMU2  Data rate = 200 Hz 
307625.639 : Extracting Group 4 : Time-tag data 
307625.649 : SNV status changed to 0  (Full Nav) 
307626.069 : Primary GPS receiver type is GPS13. 
307626.094 : Secondary GPS receiver type is GPS13. 
307626.144 : Extracting Group 10: The General Status & FDIR data. 
307626.144 : GenA( 2):  IIN quadrant resolved SET. 
307626.144 : GenA( 3):  IIN fine align active SET. 
307626.144 : GenA( 4):  IIN navigator initialized SET. 
307626.144 : GenA( 5):  IIN navigator alignment active SET. 
307626.144 : GenA( 7):  IIN full navigation solution SET. 
307626.144 : GenA( 8):  IIN initial position valid SET. 
307626.144 : GenA(16):  RAM config != NVM SET. 
307626.144 : GenB( 0):  IIN user attitude performance SET. 
307626.144 : GenB( 1):  IIN user heading performance SET. 
307626.144 : GenB( 2):  IIN user position performance SET. 
307626.144 : GenB( 3):  IIN user velocity performance SET. 
307626.144 : GenB( 8):  GAMS installation parameters valid SET. 
307626.144 : GenB( 9):  GAMS solution in use SET. 
307626.144 : GenB(10):  GAMS solution OK SET. 
307626.144 : GenB(16):  Primary GPS configuration file sent SET. 
307626.144 : GenB(18):  Primary GPS in CA mode SET. 
307626.144 : GenB(23):  Primary GPS observables in use SET. 
307626.144 : GenB(24):  GAMS secondary GPS observables in use SET. 
307626.144 : GenC( 6):  RTCM Type 1 or 9 in use SET. 
307626.144 : GenC(13):  IIN in RTCM DGPS aided mode SET. 
307626.144 : FDIR1(13): Ephemeris missing SET. 
-------------------------------------------------------------------------------- 
307626.144 : The First Group 99: Versions & Statistics 
   System Version: 
     Product-Model: MV-320; Version: VER4; Serial Number: S/N3189; 
     Hardware Version: HW3.3-7; 
     Software Release Version-Date: SW05.03-Mar10/10; 
     ICD release version: ICD04.02; 
     Operating System Version: OS425B14; 
     IMU Type: IMU2; Primary GPS Type: PGPS13; Secondary GPS Type: SGPS13; 
     Option mnemonic-Expiry Time: DMI0; 
     Option mnemonic-Expiry Time: GIM0; 
     Option mnemonic-Expiry Time: RTK-0; 
     Option mnemonic-Expiry Time: THV-0; 
     Option mnemonic-Expiry Time: DPW-0; 
   Primary GPS Version: BD950    SN:4808A98939, v.00232, channels:24; 
   Secondary GPS Version: BD950  SN:4642A73565, v.00232, channels:24; 
   Total Hours          :    789.9; Number of Runs:     66 
   Average Length of Run:   12.0; Longest Run:   84.0; Current Run:   12.2; 
-------------------------------------------------------------------------------- 
307626.144 : Diffcorr2 time1 gap: start 0.0, end 307626.1439 
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-------------------------------------------------------------------------------- 
307633.139 : Message 50: Transition to NAVIGATE mode. 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 37: Base 1 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: NAD83  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 38: Base 2 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: WGS84  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 20: General parameters 
   Time and distance tag types:          2  1 
   Autostart selection:                   ENABLED 
   Reference-IMU lever arm:              -0.008  -0.031  0.130 
   Reference-primary GPS lever arm:      1.929  -11.199  -13.076 
   Reference-auxiliary 1 GPS lever arm:  0.000  0.000  0.000 
   Reference-auxiliary 2 GPS lever arm:  0.000  0.000  0.000 
   Reference-IMU mounting angles:        0.000  0.000  0.000 
   Reference-vehicle mounting angles:    0.000  0.000  0.000 
   Multipath environment:                 LOW 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 24: User accuracy parameters 
   User position accuracy:       2.00 
   User velocity accuracy:       0.50 
   User attitude accuracy:       0.05 
   User heading accuracy:        0.05 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 106: Heave ratios 
   Heave Bandwidth (sec):  12.000 
   Heave Damping Ratio:  0.707 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 120: Heave and sensor 1&2 install parameters 
   Reference-Sensor1 alignment angles (R,P,Y) in degrees:  0.000  0.000  0.000 
   Reference-Sensor2 alignment angles (R,P,Y) in degrees:  0.000  0.000  0.000 
   Reference-Sensor1 lever arm in meters:                  0.000  0.000  0.000 
   Reference-Sensor2 lever arm in meters:                  0.000  0.000  0.000 
   Reference-Centre of Rotation in meters:                 0.000  0.000  0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 121: Vessel Installation Parameters 
   Reference-Vessel in meters:                             0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 32: PCS IP address 
   IP Address (Network part 1): 129 
   IP Address (Network part 2): 100 
   IP Address (Host part 1):    1 
   IP Address (Host part 2):    231 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 56: General data 
   Initial status:     COARSE_LEVEL 
   Initial position:   30.339738973 -88.576114608 -17.526 
   Initial distance:   0.00 
   Initial attitude:   0.000 0.000 0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 21: GAMS install parameters 
   A-B antenna separation:        8.122 
   A-B baseline vector:           0.170 8.120 -0.003 
   Heading error for calibration: 0.50 
   A-B azimuth correction:        0.000 
-------------------------------------------------------------------------------- 
 



  NOAA  
  Ferdinand Hassler   

 Page 20 of 26 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  NOAA  
  Ferdinand Hassler   

 Page 21 of 26 

 
 
 
 

 
 
 
 
Observed GAMS values derived from the field calibration: 
STRB GAMS Cal #1 
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Primary GPS data observed from internal Trimble BD950 receivers. 

 
 
Secondary embedded GPS data: 
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Com port #1 settings as installed: DGPS input from Trimble SPS Receiver. 

 
 
Com port #2 settings as installed 

 
 
Com port #3 settings as installed:  
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Com port #4 settings as installed:  
 

 
 
 
 
Com port #5 settings as installed 
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STRB POSMV Final Navigation 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  NOAA  
  Ferdinand Hassler   

 Page 26 of 26 

 
 
 
 
 
STRB side antenna and IMU mounting:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
STRB IMU Mount 

 



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: HASSLER Vessel: S250
Date: 5/31/2011 Dn: 151
Personnel: Welton, Cousins

PCS Serial # IMU Serial #

IP Address: 129.100.1.232

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 30 10 17

Lon 88 27 5

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: uk

NOAA POS/MV Calibration Report

3187 804

4814A14457

4814A14447

East of Pascagoula Ship Channel

unknown 220227632

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.732

VDOP VDOP
1.082

Sattelites in use: 12 Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Secondary GPS

N



User Entries, Pre-Calibration
Baseline Vector

0 Two Antenna Separation (m) 0 X Component (m)

0.5 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

Configuration Notes:



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:

End time:

Heading accuracy achieved for calibration: 0.26

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values
Baseline Vector

8.104 Two Antenna Separation (m) 0.152 X Component (m)

0.5 Heading Calibration Threshold 8.103 YComponent (m)

0 Heading Correction -0.004 Z Component (m)

GAMS Status Online yes

Save Settings yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)g ( g )
File Name: POSConfig_DATE (saved in GNSS folder on C drive)

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1 DPGS Correctors In

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC
$INHDT $PRDID TSS

COM2 PPS and ZDA for Reson 7125

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
None

COM3

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Heave Bandwidth
Damping Ratio

Events (Use Settings > Events)

1
Positive, Negative Edge Trigger

2

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Reference to IMU IMU Frame w.r.t Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Primary GPS Lever Arm Reference to Primary Vessel Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Centre of Rotation Lever Arm
X (m)

Reference frame and vessel frame are co-aligned Y (m)
Z (m)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time Medium
UTC Time High

Time Tag 2 Auto Start
POS Time Disabled
GPS Time Enabled
UTC Time
User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm Reference to Aux. 2 GPS Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Sensor 1 Lever Arm Sensor 1 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Sensor 2 Lever Arm Sensor 2 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)



User Parameter Accuracy (Use Settings > Installation > User Accuracy)

RMS Accuracy
Attitude (deg)
Heading (deg)
Position (m)
Velocity (m/s)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Hassler Vessel: S250 Stbd
Date: 5/31/2011 Dn: 151
Personnel: Welton, Cousins

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:
Approximate Position: Lat 30 10 17

Lon 88 27 5

DGPS Beacon Station: DGPS Receiver Serial#:
Frequency: uk

Satellite Constellation (Use View> GPS Data)

NOAA POS/MV Calibration Report

3189 803

4808A98939

4624A37565

East of Pascagoula Ship Channel

unkown 220227632

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.742 0.741

VDOP VDOP
1.081 1.082

Sattelites in use: 12 Sattelites in use: 12

L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.366 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration
Baseline Vector

0 Two Antenna Separation (m) 0 X Component (m)

0.5 Heading Calibration Threshold 0 YComponent (m)

0 Heading Correction 0 Z Component (m)

Secondary GPS

N



Configuration Notes: Used manual calibration.



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:

End time:

Heading accuracy achieved for calibration: 0.26

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values
Baseline Vector

8.12 Two Antenna Separation (m) -0.046 X Component (m)

0.5 Heading Calibration Threshold 8.12 YComponent (m)

0 Heading Correction 0.015 Z Component (m)

GAMS Status Online yes

Save Settings yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: POSConfig (saved under c:\GNSSData)

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1 DGPS Corrector

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC
$INHDT $PRDID TSS

COM2 ZDA and PPS for Reson 7125 and 7111

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select
NNone

COM3 TSS motion string for Reson 7111

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line

COM4 GGA and VTG for Side Scan

Baud Rate Rate Parity Data Stop

Output Select
None

Input Select Input

? Input Type

Line





SETTINGS Continued
Heave Filter (Use Settings > Heave)

Heave Bandwidth
Damping Ratio

Events (Use Settings > Events)

1
Positive, Negative Edge Trigger

2

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Reference to IMU IMU Frame w.r.t Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Primary GPS Lever Arm Reference to Primary Vessel Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Centre of Rotation Lever Arm
X (m)

Reference frame and vessel frame are co-aligned Y (m)
Z (m)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time Medium
UTC Time High

Time Tag 2 Auto Start
POS Time Disabled
GPS Time Enabled
UTC Time
User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm Reference to Aux. 2 GPS Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Sensor 1 Lever Arm Sensor 1 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Sensor 2 Lever Arm Sensor 2 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)



RMS Accuracy
Attitude (deg)
Heading (deg)
Position (m)
Velocity (m/s)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



Appendix IV 
 
 
Sound Speed Sensor Reports 
 















AML Calibration Equipment 

Temperature Calibrations 

Performed using either of two Hart Scientific "Black Stack" Model 1560 Power Bases with attached 
Hart Scientific Model 2563 Thermistor Modules connected to a Thermometrics AS125 4 Wire 
Thermistor Standard

1: Hart Scientfic  Power Base 1560 S/N 79263 /  Thermistor Module  2563 S/N 79039 / 
Thermometrics AS125 4  Wire Thermistor Standard S/N 2131
2: Hart Scientfic power Base 1560 S/N A05690 / Thermistor Module 2563 S/N A05693 / 
Thermometrics AS125 4 Wire Thermistor Standard S/N 2128

Temperature calibration equipment is calibrated yearly and verified bi-monthly as per Applied 
Microsystems Ltd. Calibration Schedule T11.2 utilizing a Hart Scientific Model 5901 Triple Point of 
Water Cell. All temperature calibrations and verifications are ITS-90 and NIST traceable

Pressure Calibrations  

Performed using a Budenburg Model 380D S/N 18564 Range 0-8000 psi Deadweight Tester. 
Calibrations and verifications are implemented as per Applied Microsystems Ltd. Calibration 
Schedule T11.2. All pressure calibrations and verifications are NIST traceable.

Conductivity Calibrations  

Performed using either of two Guildline 8400B  S/N 59251 or Guildline 8400  S/N  43385 Autosals. 
Both Conductivity Calibrators are calibrated and verified using Ocean Scientific International IAPSO 
Standard Seawater as per Applied Microsystems ltd. Calibration Schedule T11.2. All Conductivity 
Calibrations and verifications are NIST traceable

Battery Channel Calibrations  

Performed using a Precision Fluke Model 45 Multimeter S/N 4720162. Calibrations and verifications 
are implemented as per Applied Microsystems Ltd. Calibration Schedule T11.2 All calibrations and 
verifications are NIST traceable.
 
Sound Velocity Calibrations 

Performed using an Applied Microsystems Ltd Temperature Standard  S/N 9998 in distilled water, 
<5 ppm TDS, and sound velocity reference is Del Grosso and Mader's Pure Water Equation. 
Calibrations and verifications are implemented as per Applied Microsystems Ltd. Calibration 
Schedule T11.2 All temperature calibrations and verifications are ITS-90 and NIST traceable. 



Conductivity Calibration

Date  10/16/09
S/N  007760
Calibrator Wanda Turple
RMS Error 0.0002
Range 0 to 7 S/m

mS/cm=A+B*Nte+C*Nte^2+D*Nte^3+(E+F*Nte+G*Nte^2+H*Nte^2)*Raw

A=-1.152428E-2 G=1.893281E-11
B=9.157882E-7 H=-5.385734E-14
C=-8.103243E-9 I=0.000000E+00
D=2.305094E-11 J=0.000000E+00
E=2.692588E-5 K=0.000000E+00
F=-2.139692E-9 L=0.000000E+00

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655
Canada & USA: 800-663-8721
Email: info@amloceanographic.com Web: http://www.amloceanographic.com



Pressure Calibration

Date  10/08/09
S/N  007760
Calibrator Wanda Turple
RMS Error 0.058
Range 1000 dBar

dBar=A+B*T+C*T^2+D*T^3+(E+F*T+G*T^2+H*T^3)*Raw+(I+J*T+K*T^2+L*T^3)*Raw^2

A=1.169427E+2 G=-2.518083E-9
B=2.159378E-2 H=1.881585E-14
C=-1.091023E-6 I=1.829127E-5
D=1.027632E-11 J=-1.261447E-9
E=-1.650542E+0 K=2.899260E-14
F=1.123778E-4 L=-2.220854E-19

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655
Canada & USA: 800-663-8721
Email: info@amloceanographic.com Web: http://www.amloceanographic.com



Temperature Calibration

Date  10/16/09
S/N  007760
Calibrator Wanda Turple
RMS Error 0.0004
Range -2 to +32 Deg C

Deg C=A+B*Raw+C*Raw^2+D*Raw^3+E*Raw^4+F*Raw^5+G*Raw^6

A=-9.720103E+0 G=-2.749893E-29
B=8.715852E-4 H=0.000000E+00
C=-8.615532E-9 I=0.000000E+00
D=1.629973E-13 J=0.000000E+00
E=-1.785860E-18 K=0.000000E+00
F=1.317008E-23 L=0.000000E+00

2071 Malaview Ave West, Sidney, British Columbia, Canada V8L 5X6
Phone: (250) 656-0771 Fax: (250) 655-3655
Canada & USA: 800-663-8721
Email: info@amloceanographic.com Web: http://www.amloceanographic.com



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0276
CALIBRATION DATE: 15-Feb-09 

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  4.876460e-006

a1 =  2.820307e-004

a2 = -3.073148e-006

a3 =  1.663229e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             695526.7             1.0000             -0.0000

   4.5000             593239.1             4.5001              0.0001

  15.0000             375466.3            14.9999             -0.0001

  18.4999             324396.7            18.4999             -0.0000

  23.9998             259363.7            24.0001              0.0003

  29.0001             212937.1            28.9998             -0.0003

  32.5000             186097.5            32.5001              0.0001

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2
(n)] + a3[ln

3
(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0276
CALIBRATION DATE: 15-Feb-09 

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.000413e+000

h =  1.568807e-001

i = -2.349823e-004

j =  4.488494e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC =  4.2855e-007

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2527.72    0.00000      0.00000

   1.0000    34.8168    2.97600    5035.29    2.97601      0.00001

   4.5000    34.7972    3.28310    5225.41    3.28310     -0.00000

  15.0000    34.7546    4.26484    5790.71    4.26483     -0.00002

  18.4999    34.7451    4.60993    5976.45    4.60993     -0.00001

  23.9998    34.7341    5.16773    6264.77    5.16776      0.00003

  29.0001    34.7263    5.68925    6522.45    5.68924     -0.00001

  32.5000    34.7200    6.06109    6699.95    6.06109     -0.00000

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0277
CALIBRATION DATE: 15-Feb-09 

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.268100e-005

a1 =  2.854515e-004

a2 = -3.347123e-006

a3 =  1.747491e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             638612.3             0.9999             -0.0001

   4.5000             544690.8             4.5001              0.0001

  15.0000             344730.4            14.9999             -0.0001

  18.4999             297839.2            18.4998             -0.0001

  23.9998             238125.7            24.0000              0.0002

  29.0001             195496.2            29.0000             -0.0001

  32.5000             170855.0            32.5000              0.0000

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2
(n)] + a3[ln

3
(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0277
CALIBRATION DATE: 15-Feb-09 

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -9.768655e-001

h =  1.532775e-001

i = -2.703518e-004

j =  4.580328e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC =  4.2855e-007

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2527.73    0.00000      0.00000

   1.0000    34.8168    2.97600    5081.46    2.97601      0.00000

   4.5000    34.7972    3.28310    5274.50    3.28310      0.00000

  15.0000    34.7546    4.26484    5848.23    4.26483     -0.00001

  18.4999    34.7451    4.60993    6036.68    4.60992     -0.00001

  23.9998    34.7341    5.16773    6329.15    5.16776      0.00003

  29.0001    34.7263    5.68925    6590.49    5.68924     -0.00001

  32.5000    34.7200    6.06109    6770.48    6.06109     -0.00000

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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